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by Jay Anderson ( jander@cc.umanitoba.ca)

W
e have travelled to the end of year one under this

Editor’s tutelage. Since last October the editors,

proofreaders, authors, photographers, graphic artists,

and scientists who form the backbone of the JRASC have helped

make some fairly big changes — the Journal now reflects its

amateur audience a little better and the content is more varied.

Most of you seem to like it, judging by the letters and emails

that arrive from time to time, though there are a few who are

nostalgic for the Journal of Christmases Past. 

Nevertheless, I feel that there is a part of the journey

remaining to be made. We need material that reflects the broader

range of RASC achievement — drawings, poems, insights, special

moments, and also technical articles about mounts, observing

aids (pass these ideas to Don Van Akker), observatories, digital

processing (we all have digital cameras now, don’t we?), star

parties, and science. 

So I’m challenging you to make the Journal even more

RASC-like. We have a great collection of editors, many of whom

focus on a particular topic. If you observe variable stars, send

some of your insights and results to Rick Huziak. If you tackle

asteroid occultations, let Guy Nason know what you’re doing.

Ask Warren Finlay or Doug Hube what they plan to feature in

their next article and take a photo of the object for them - we’d

prefer to use a member’s images rather than those that come

from Hubble. Argue with Geoff Gaherty, or provide him with

your “through the eyepiece” story. If you know of a dynamite

Web site, let Paul Langan know — he may have the byline, but

we’ll put your recommendation into print and give you the

credit. Send us a sonnet, a haiku, or even a cartoon — we’ll add

them to the mix.

One of my bigger disappointments is the lack of content

from our women astronomers. There is a women’s perspective

out there: these may be special insights into astronomy, personal

“aha!” moments, or Leavitts and Cannons who need a little

recognition. More than half of the new graduates in astronomy

in the U.S. are women, but that achievement hasn’t yet reached

the pages of the JRASC. 

Astronomy has the Universe as its sandbox. You’ve seen

some of the new ideas in our pages already, and your Editor

would like to see many more.

Editorial

mailto:editor@rasc.ca
http://www.rasc.ca
mailto:dhube@phys.ualberta.ca
mailto:attasm@aecl.ca
mailto:semore@sympatico.ca
mailto:jamesedgar@sasktel.net
mailto:jamesedgar@sasktel.net
mailto:nationaloffice@rasc.ca
http://www.rasc.ca
mailto:jander@cc.umanitoba.ca


JRASCOctober / octobre 2006 191

News Notes
En Manchettes

Launched in June 1999 and originally designed for a three-year

mission, NASA’s Far Ultraviolet Spectroscopic Explorer astronomy

satellite is back in full operation. The FUSE satellite is working

again thanks to a team of scientists and engineers at the operations

centre in Johns Hopkins University who reprogrammed its

onboard software control system during 2005 to continue the

mission. FUSE had a near-death experience in December 2004

when the third of four onboard reaction wheels stopped spinning,

depriving the satellite of stability and fine-pointing capacity.

“This return to operation is great news,” declared Jean

Dupuis, astronomer at the Canadian Space Agency. “With its

high sensitivity and great powers of resolution, FUSE will keep

providing Canadian and foreign astronomers with very interesting

research opportunities.”

FUSE now operates using onboard magnetometers for

slewing, and uses its Canadian-built Fine Error Sensor cameras

to measure drift rates after slews. Such functions were never

intended for these components in the original design. In January

2006, FUSE operations were returned to efficiency levels seen

early in the mission. Now the satellite will continue a broad

range of science programs for hundreds of astronomers from

around the world. To date, more than 350 publications based

on FUSE observations have been published in the professional

astronomy literature and many more are on the way. Canadian

scientists have authored 74 of these publications.

FUSE is an orbiting telescope jointly run by NASA, the

Canadian Space Agency, and the Centre national d’études

spatiales, in Toulouse, France. Canada contributed the Fine

Error Sensor camera system for tracking the telescope; it was

built by COM DEV with technical advice and design work from

the Herzberg Institute of Astrophysics in Victoria, B.C. FUSE

partners also include Honeywell Technical Services Inc., the

Johns Hopkins Applied Physics Laboratory, the University of

Colorado at Boulder, the University of California, Berkeley, and

the Orbital Sciences Corporation. France supplied the unique

spectroscopic gratings.

Observations from the satellite have been used to discover

an extended, tenuous halo of very hot gas surrounding our Milky

Way galaxy; evidence of similar hot gas haloes around other

galaxies has also been found. FUSE has detected molecular

hydrogen in the atmosphere of the planet Mars for the first

time. This has implications for the water history of our frozen

neighbour. In addition, FUSE observations first detected molecular

nitrogen in dense interstellar gas and dust clouds, but at levels

well below those that astronomers had expected, requiring a

return to the drawing board for theories of interstellar chemistry.

ROM, Toronto, Ont.: With the third-largest collection of meteorites

in Canada, including over 500 specimens from 170 different

meteorites, the Royal Ontario Museum (ROM) has now acquired

a 200-gram fragment of the important Tagish Lake Meteorite.

This meteorite is renowned as the only one in the world ever

to be collected and preserved in pristine condition, frozen and

uncontaminated. A 52-gram portion will be displayed in the

ROM’s upcoming Inco Limited Gallery of Minerals, Gems, and

Jewels (opening in 2008).

The icy meteorite fell on the frozen surface of Tagish Lake,

northern British Columbia, on January 18, 2000. Weighing about

one kilogram, the specimen is rich in pre-solar grains and those

from other stars that were present near our Solar System when

it formed. It contains primitive molecules that are the building

blocks necessary for life. The remarkable state of the meteorite

makes it especially important for scientific study, presenting

an unprecedented opportunity to look at extraterrestrial ices.

Compiled by Martin Beech (beechm@uregina.ca) and Russ Sampson (sampsonR@easternct.edu)

CANADIAN CAMERA HELPS MEND FUSE

Figure 1 – The FUSE satellite is seen superimposed on an optical image
of the Small Magellanic Cloud, a satellite galaxy of the Milky Way. At
a distance of only 200,000 light years, the Small Magellanic Cloud is of
intense interest to astronomers and well suited to FUSE observations.
Over 100 individual stars in this galaxy have been observed to date. At
far right is the globular cluster 47 Tuc, whose UV-bright stars have also
been studied with FUSE. (Graphic courtesy NASA and Lauren Fowler,
the JHU FUSE project.)

TAGISH LAKE METEORITE IN ROM COLLECTION

mailto:beechm@uregina.ca
mailto:sampsonR@easternct.edu
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It may be one key in advancing our understanding of the formation

of our Solar System.

In November 2005, the Minister of Canadian Heritage

approved a Movable Cultural Property grant to assist the ROM

and three partners in purchasing portions of the Tagish Lake

Meteorite to ensure that all fragments could be retained in

Canada for research purposes. Other recipients of portions of

the meteorite are the University of Alberta (Figure 2), the Ministry

of Canadian Heritage, Natural Resources Canada, and the

Canadian Space Agency.

Meteorites are an invaluable and relatively inexpensive

source of information about outer space, used by scientists to

study the Universe. As most meteorites date from about 4.6

billion years ago, they provide clues about the nature and origin

of our Solar System and the interior of planets. Acquisition of

the Tagish Lake Meteorite gives Canadian scientists an opportunity

to enhance their expertise in the handling and analysis of

extraterrestrial material by working with international planetary

scientists on this pristine material of unprecedented scientific

value.

Further details on the ROM and what can be seen there

can be found at www.rom.on.ca/index.php

An international team of astronomers, lead by Dr. Chris Blake

(Astronomy Department, University of British Columbia), has

recently presented new results on the cosmos, based on the

largest map of the heavens ever produced. (The findings are

presented in “Cosmological parameters from a million photometric

redshifts of SDSS Luminous Red Galaxies,” a paper submitted

to Monthly Notices of the Royal Astronomical Society: a preprint

is available athttp://xxx.arxiv.cornell.edu/abs/astro-ph/0605303).

This massive atlas emphatically confirmed recent findings

that the Universe is full of dark energy, a mysterious substance

that makes up three-quarters of our Universe, together with

“dark matter,” which accounts for most of the remaining quarter.

Understanding this composition is now one of the most important

problems facing the whole of science.

“We now have a precise view of what makes up our Universe,

but little idea as to why,” said Prof. Ofer Lahav, a member of the

international team and the Head of the Astrophysics Group at

University College London. “It is intriguing that the ordinary

matter our bodies are made of and that we experience in everyday

life only accounts for a few percent of the total cosmic budget.”

Our Universe contains billions of galaxies of all shapes and

sizes. In recent years, astronomers have used increasingly large

surveys to map out the positions of these galaxies, gradually

stepping their way out into the cosmos. The new map is the

largest made to date and provides a 3-D atlas of over a million

galaxies spread over a distance of more than five billion light

years. The findings confirm that we live in a Universe filled with

mysterious dark matter and dark energy.

“We have analyzed the patterns in this map and discovered

waves of structure over a billion light years across,” said Dr.

Chris Blake of the University of British Columbia, principal

author of the study. “These waves were generated billions of

years ago and have been vastly stretched in size by the expanding

Universe.”

Construction of the cosmic atlas was led by co-author Dr.

Adrian Collister of the University of Cambridge, as part of his

Ph.D. work, using a novel artificial-intelligence technique he

developed with his supervisor, Prof. Ofer Lahav.

“By using very accurate distances of just 10,000 galaxies

to train the computer algorithm we have been able to estimate

reasonably good distances for over a million galaxies,” said

Collister. “This novel technique is the way of the future.”

The original 2-D positions of colours of the one million

galaxies were from the Sloan Digital Sky Survey.

The precise observations of the 10,000 galaxy distances

were made as part of an international collaboration between

U.S., U.K., and Australian teams using data from the Sloan

Digital Sky Survey and the Anglo-Australian Telescope.

By measuring the positions of galaxies, astronomers can

unravel the balance of forces that govern our Universe: the force

of gravity that pulls everything together and the competing

Figure 2 – A 153-g piece of the Tagish Lake Meteorite now
forming part of the University of Alberta’s meteorite collection.
Image credit: Michael Holly, University of Alberta. Further details
at www.museums.ualberta.ca/dig/naturalhist/earth/
meteorite/index.html

3-D MAP OF A MILLION GALAXIES

http://www.rom.on.ca/index.php
http://xxx.arxiv.cornell.edu/abs/astro-ph/0605303
http://www.museums.ualberta.ca/dig/naturalhist/earth
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effect of the expanding Universe that smoothes things out.

These cosmic forces have arranged the galaxy distribution into

a complex network of clusters, filaments, and voids.

“The galaxy map can tell us the amount of ordinary baryonic

matter relative to the amount of mysterious dark matter,” said

co-author Dr. Sarah Bridle of University College London. “We

have confirmed that over 80% of the material in the Universe

consists of an invisible dark matter whose nature is not yet

understood.”

The cosmic atlas of a million galaxies will shortly be made

freely available on the World Wide Web for the benefit of other

researchers. This free exchange of data is an important feature

of modern astronomy, since many discoveries are only possible

when different observations are combined.

The key problem in mapping the cosmos is determining

the distance to each galaxy. Researchers can measure these

distances because, as the Universe expands, the colour of each

galaxy changes as their emitted light waves are stretched or

redshifted. Traditionally, astronomers have needed to take a

spectrum of each galaxy to determine this distance, splitting

its light into many components to reveal sharp features with

which to measure the amount of redshifting. This requires a

time-consuming, individual observation of each galaxy.

The new cosmic map has been constructed using a novel

technique focusing on a special class of galaxy whose intrinsic

colour is very well known. For these Luminous Red Galaxies

researchers can measure the amount of colour distortion, and

hence the approximate distance of the galaxy, just by looking

at digital images of the sky, without the need to obtain a full

spectrum.

All that is needed to exploit the technique is accurate

observations of a small sample of the galaxies. In this case,

precise measurements of just 10,000 galaxies were used to

produce the atlas of over a million galaxies. These techniques

will be very important for future large astronomical projects

such as the Dark Energy Survey, scheduled to start in 2009, in

which University College London and the universities of

Portsmouth, Cambridge, and Edinburgh are key partners.

A large image map for the locations of the different classes

of galaxies can be found at www.star.ucl.ac.uk/~lahav/

Galaxymap.JPG

Correspondence
Correspondance

What is this object?

On the attached image of the stamp issued

by the United States Post Office in 1973 to

commemorate the 500th year of the birth of

Nicholas Copernicus, there is an unusual

object being held by Copernicus. What is

and what is it called?

The portrait on this stamp is originally

from a 1740’s image that shows Copernicus

holding a simplified “planetaria” of sorts, a symbol of his

heliocentric universe. What is this object depicted in this image?

Does an example of this object really exist or was it just a prop

added by the artist to “symbolize” the new concept of the then

known solar system? It is hoped that some of the readers may

be able to assist in determining the above questions.

If you have any knowledge of the above, please contact

Rick Stankiewicz at 10 Hazel Cresc, RR 8, Peterborough ON

K9J 6X9 or stankiewiczr@nexicom.net

Your assistance would be greatly appreciated.

Rick Stankiewicz

WEB ACCESS TO THE 2006 ISSUES OF THE JRASC

The 2006 issues of the Journal can be accessed from the RASC Web site at www.rasc.ca/currentjrasc (userid=“jrasc”; password=
“pelican”). Issues are posted immediately after the final production version is complete.

http://www.star.ucl.ac.uk/~lahav
mailto:stankiewiczr@nexicom.net
http://www.rasc.ca/currentjrasc
www.star.ucl.ac.uk/~lahav/Galaxymap.JPG
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1 Introduction

T
he radiation of a meteor is mainly produced by hot vapours

and a heated atmosphere around the evaporating meteoroid.

This radiation, which produces the familiar “shooting

star,” has a point-like or nearly circular form and disappears

after the meteoroid evaporates. However, even observation by

the naked eye can, in some cases, reveal different kinds of

radiation following the meteoroid in space and time. These

luminous phenomena can be found in literature under various

names such as afterglow, wake, trail, or train. They may be

separated by tens of metres up to many kilometres from the

meteoroid and may last from a fraction of second up to more

than an hour after the meteor disappearance.

The studies of these phenomena require the gathering

of complex data on their temporal evolution, morphology,

height in the atmosphere, and spectra. The amount of data

has increased considerably in the recent years, mainly thanks

to the observations of Leonid meteors. It is now clear that

various physical and chemical processes are responsible for

the formation of meteor-induced luminous objects but all

the processes are still not well understood. This paper

presents a summary of observational facts and their current

interpretations.

Meteor Trains -
Terminology and Physical Interpretation
by Jiří Borovička, Astronomical Institute of the Academy of Sciences, 251 65 Ondřejov, Czech Republic, email: borovic@asu.cas.cz

Abstract

This article presents a summary of various luminous phenomena that may follow after passage of a meteor. The terminology

recommended by the International Astronomical Union in 1961 is used, which calls these phenomena trains. Nowadays,

several types of trains can be clearly distinguished. The understanding of the underlying physical and chemical processes

is, however, still not satisfactory and the nomenclature of different train phenomena has not yet been settled. In this paper

I call them wake, green train, persistent train, and reflection train. Meteor wakes are formed by rarified non-equilibrium

gas behind the meteoroid. The green train, produced by the radiation of the forbidden oxygen line at 557.7 nm, is created

by reactions among atmospheric species. The persistent train is the most complex phenomenon with three phases of evolution.

The afterglow phase is formed by cooling rarified gas. After that, atomic recombination phase follows. The third and most

persistent continuum phase is probably fed by chemiluminescence. Finally, the reflection train occurs when sunlight is

scattered by a dust cloud created by meteoroid disruption.

Résumé

Cet article présente un sommaire des différents phénomènes lumineux résultant du passage d’un météore. La terminologie

recommandée par l’Union astronomique international en 1961, qui nomme ces phénomènes trainées, est employée ici.

Actuellement plusieurs catégories de trainées se distinguent. Toutefois une compréhension des processus physiques et

chimiques sous-jacents n’est toujours pas claire et la nomenclature des differents phénomènes de trainées n’a pas encore

été établie. Dans cet article, je les nomme sillage, trainée verte, trainée persistante, et trainée réfléchissante. Les sillages

météoriques sont formés par des gaz rarifiés non-équilibrés derrière le météore. La trainée verte, résultant de la radiation

de la ligne interdite d’oxygène à 557.7 nm, est produite par les réactions parmi les molécules atmosphériques. La trainée

persistante est la plus complexe affichant trois phases d’évolution. La phase de derniers reflects est produite par le

refroidissement des gaz rarifiés. Après quoi suit la phase de la recombinaison atomique. La troisième et la plus persistante

des phases est tout probablement le résultat de chimiluminescence. Enfin, la trainée réfléchissante se produit lorsque la

lueur du soleil est éparpillée par le nuage de poussière provenant de la perturbation météorique.
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2 Terminology

Many years ago, the International Astronomical Union (IAU)

defined standard terms for meteoric astronomy in four languages

— English, French, Russian, and German (Millman 1961). The

purpose was to provide a fairly short list of very basic terms

that would be clear to the nonspecialist and that would have a

reasonable leeway in interpretation. The English list, which can

be found on www.amsmeteors.org/define.html, contains

three terms related to the topic of this paper. Train is defined

as “anything (such as light or ionization) left along the trajectory

of the meteor after the head of meteor has passed.” The adjective

persistent for use with train is defined as “indicating durations

of some appreciable length.” Finally, wake is defined as “train

phenomena of very short duration, in general much less than

a second.” The frequently used term trail has been omitted from

the list because there is only one Russian translation for the

two English words trail and train.

In the following, I will use the IAU terminology. The fact

that several types of trains exist will require the invention of

more terms in the future. In the ideal case, detailed terminology

should reflect the physical or chemical processes responsible

for train formation. In the meantime, we have to use observational

characteristics to distinguish individual types of trains.

3 Train types

In principle, the formation of a meteor train likely depends on

the mass, velocity, and composition of the incoming meteoroid,

on the properties of the atmosphere (which vary in diurnal cycle

and according to the solar activity), and on the height of deposition

of meteoric energy and mass. Under various conditions, several

types of trains may or may not be formed. One meteor can

produce more than one type of train.

3.1 Wakes

Morphologically, a meteor wake is a luminosity just behind the

meteor head. It moves with the meteor and forms a kind of tail.

The wake is often present in bright fireballs, which are then

sometimes described as comet-like objects by witnesses. The

length of the wake can exceed one kilometre. At a given position,

the wake duration is usually less than 0.1 second.

The spectrum of the meteor wake is different from the

spectrum of the meteor head. The wake spectrum consists

chiefly from low excitation lines. The lines belong to Na I, Fe I,

Mg I, Ca I, and other atoms released from the meteoroid. For a

more detailed line list, see Halliday (1968). The presence of lines

with low-transition probability, which are usually faint in meteor

heads, is typical for wake radiation. The reason is that while

the head is close to thermal equilibrium the wake is not. In the

rarified conditions behind the meteoroid, collisions between

atoms and electrons are infrequent and the collisions are unable

to keep level populations in atoms in equilibrium.

The gas responsible for the wake radiation can come directly

from the meteor head or may be produced by ablation of tiny

dust particles released from the meteoroid. The wake is usually

strongest at heights above 55 km, as was the case of the Benešov

fireball (Borovička & Spurný  1996). In the denser atmosphere

at lower heights, hydrodynamic conditions seem to be less

favourable for the formation of this non-equilibrium wake.

However, a wake of different kind may be formed after meteoroid

fragmentation at lower heights. Macroscopic fragments behave

as individual meteors that lag behind the main body. If individual

fragments cannot be resolved, the whole formation resembles

a wake. This kind of wake is sometimes called a particulate

wake. Its spectrum is quite similar to the spectra of meteor

heads.

The particulate wake can form wherever the meteoroid fragments.

Fisher et al. (2000) searched for wake in faint sporadic meteors.

Only a minority of the observed meteors showed a detectable

wake.

3.2 Green trains

The short-duration train formed exclusively by the green oxygen

line at 557.7 nm will be provisionally called green train in this

paper. The presence of the green oxygen line in meteor spectra

was discovered by Halliday (1958) and studied by Millman,

Cook, & Hemenway (1971) using TV spectroscopy. No paper on

this subject has been published in recent years. I will summarize

the basic facts using my experience from Ondr̆ejov TV spectroscopy.

The occurrence of green train is typical for high-velocity

meteors of medium and low brightness. The train can be easily

seen visually for one or two seconds after meteor disappearance

when observing Leonids or Perseids (though the colour is hard

to recognize). It occurs marginally in Geminids (36 km s-1) but

not in slower meteors. Figure 1 shows the evolution of the train

in a Leonid meteor. At a given position, the green line appears

with a short delay after the passage of the meteoroid and reaches

maximum intensity after about 0.1 second. The intensity then

Figure 1 — Three frames from the video sequence of a Leonid meteor
spectrum showing the formation of green oxygen train. The exposure
time of each frame was 0.04 s. The frames are separated by 0.20 s.
Frame a shows a relatively faint train. At frame b, the meteor moved
down and the train intensified. At the time of frame c, the meteor has
disappeared and the train is still glowing.

http://www.amsmeteors.org/define.html
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starts to decay. Green trains are not visible for longer than about

3 seconds. The typical height where the green line is brightest

and lasts longest is 105 km. This is often valid also when the

meteor reaches maximum brightness at lower height. In very

bright meteors, the green line can span a large height interval,

e.g. from 80 km to 140 km. However, it decays quickly. Moreover,

the green line intensity is not directly proportional to the meteor

brightness and the green train is only a minor effect in bright

fireballs. In faint meteors (+4 mag), the green line can be the

strongest feature in the spectrum.

The fact that the green line intensity is not correlated with

the meteor ablation rate supports the idea that the line is

produced by atmospheric oxygen. The green line is a forbidden

line; it is formed by a transition with very low transition probability.

The upper level is a metastable level with radiative lifetime of

0.75 s. This can explain the train duration. The energy of the

upper level is 4.2 eV. Baggaley (1976a) concluded that the most

plausible excitation mechanism is charge transfer from O+ to

O+
2 followed by dissociative recombination. The collisional

deactivation of the metastable level at lower heights is responsible

for the maximum line intensity at 105 km (Baggaley 1976b).

The dependence of line brightness on meteor velocity was

studied by Baggaley (1977a).

3.3 Persistent trains

Self-luminous persistent trains, which can be visible for tens

of minutes after meteor disappearance, have drawn the attention

of observers since the 19th century (Trowbridge 1907). These

are rare phenomena produced only by bright fireballs of high

velocity. In the first approximation, brighter and faster meteors

produce brighter and longer duration trains. Leonid meteors

moving at 71 km s-1 are particularly favourable for producing

persistent trains. A number of papers on Leonid trains have

been published recently and whole catalogues have been compiled

(Higa et al. 2005). Despite this effort, persistent trains are still

far from being fully understood.

Persistent trains always form in the region of meteor

maximum brightness, often at the position of a bright meteor

flare. Their luminosity is therefore driven by the energy and

material deposited in the atmosphere by the meteoroid. Persistent

trains usually form somewhere between the heights of 75 and

100 km. Train properties and evolution may depend on the

height but we will not go in such details in this paper. At the

time of formation, the train may be very bright, exceeding

magnitude -5 (e.g. Borovička & Jenniskenns 2000). The brightness

then falls quickly within few seconds; this initial stage may be

called the afterglow phase. Altogether, three distinct phases of

train evolution have been identified (Borovička & Koten 2003).

3.3.1 Afterglow phase

The afterglow phase was studied in detail by Borovič ka &

Jenniskens (2000). The afterglow spectrum has the same character

as the spectra of meteor wakes. Atomic lines of low excitation

dominate, including lines with low transition probability. The

line decay rate was found to be proportional to the upper

excitation potential. These facts were interpreted in terms of

cooling of low density non-equilibrium gas. The excitation

temperature dropped from 4500 K to 1200 K in two seconds.

Other trains produced by fainter meteors and analyzed by other

methods exhibited faster cooling ( Jenniskens & Stenbaek-

Nielsen 2004; Abe et al. 2005). The cooling of the train analyzed

by Borovička & Jenniskens (2000) was slower not only because

of larger mass of the meteoroid but also because of secondary

ablation of the dust in the train. Some parts of the train were

still moving with a velocity of 2 km s-1 when the train formed.

3.3.2 Recombination phase

After the initial fading, the brightness of some lines stabilizes

and a few even gain brightness. The train evolves into a second

phase. This phase usually lasts several tens of seconds and is

also characterized by atomic line emission. Although the spectrum

is similar to the spectrum in the afterglow phase, the significant

difference is that lines of higher excitation (up to 7 eV) are also

present. The main difference in the visible region, as shown in

Fig. 2, is the presence of Mg I line at 517 nm. In the afterglow,

there are two lines of Fe I of the same brightness at 510 and 517

nm. By chance, the second line almost coincides with the

Mg I line. However, the brightness ratio of the Fe I lines cannot

change, so if the 517 nm line is much brighter it must be due

to Mg I. There are, nevertheless, many more high excitation

lines across the spectrum from the ultraviolet to infrared (Suzuki

2003, Borovička & Koten 2003, Abe et al. 2005), most notably

Mg I at 383 nm. The two brightest lines in train spectra, Mg I

Figure 2 — The spectrum of a Leonid persistent train in the recombination
phase, eight seconds after train formation. The three brightest lines,
from the left to the right are Mg I (457 nm), Mg I (517 nm), and Na I (589
nm). The inset contains spectrum of another Leonid train in the afterglow
phase, 0.05 s after meteor disappearance. The two dominant lines in
the middle are Fe I (510 and 517 nm). The O I line at 558 nm is present
and shifted up. The Na I line is at the edge of the field of view. From
Borovička & Koten (2003).
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517 nm and Na I 589 nm, were identified by visual spectroscopy

130 years ago (von Konkoly 1874). The identification of forbidden

nebular lines by Borovička et al. (1996) was incorrect.

The spectra of ~10-s-old trains also contain the band of

molecular oxygen O2 near 865 nm (Suzuki 2003, Abe et al. 2005).

The oxygen molecule is excited by thermal processes. From the

shape of the band, Abe et al. (2005) inferred a rotational

temperature of 250 K. This temperature is insufficient to excite

atomic lines. Borovička & Koten (2003) have shown that the

observed line spectrum can be explained by recombination

processes. Positive ions (e.g. Mg+) gain electrons to excited levels

and lines of neutral atoms are then produced during the downward

cascade of the electrons. Recombination is more efficient at

lower temperatures, so the intensity of the recombination lines

such as Mg I 517 nm increases after the train has cooled (Spurný,

Borovič ka, & Koten 2005). There are indications that the

recombination does not proceed with free electrons but rather

with negative ions as predicted theoretically by Baggaley (1977b).

The afterglow phase and recombination phase may not

occur in all trains. Spurný , Borovička, & Koten (2005) observed

two relatively faint and short trains (several seconds duration),

one of them showed only the afterglow phase and the other only

the recombination phase.

3.3.3 Continuum phase

When the recombination lines have faded, a minimum in train

brightness occurs followed by a subsequent brightening. This

brightening can be stronger in some parts of the train than in

the others. Variations in the direction and strength of the

atmospheric winds with the height cause train deformation

(Drummond et al. 2001, Jenniskens & Rairden 2000). Persistent

trains therefore often gain curious shapes after several minutes.

Morphologically, two types of trains were distinguished (Drummond

et al. 2002). A Type I train is wide, cloudy in appearance, bright,

and has high diffusion rate. The fainter Type II train is narrow

and has much lower diffusion rate. In fact, Type II trains were

not observed separately: they form in sections of trains that are

otherwise Type I. Both types appear often double under high

resolution, i.e. they look like a pair of parallel trains. This

appearance was previously explained by hollow tube nature of

the trains (Trowbridge 1907) but this explanation has proved

to be inadequate (Kruschwitz et al. 2001). Other explanations

proposed recently include meteoroid fragmentation (Jenniskens

2003), train separation into gaseous phase and dust (Kelley et

al. 2003), as well as buoyant rise and split into a pair of parallel

line vortices (Zinn & Drummond 2005).

Not only the train morphology but also the fundamental

question of train luminosity is incompletely understood. Low-

resolution train spectra show a broad continuous emission with

a maximum near 590 nm and possibly another maximum in

the near infrared (Borovička & Koten 2003). Although a minor

contribution of the Na I line (593 nm) is not excluded, most

luminosity must be produced by molecules. The emitting

molecules have not been identified with certainty. Jenniskens

et al. (2000) claimed the identification of FeO, but FeO is not

able to explain the whole spectrum. Other possible contributors

are OH (Clemesha et al. 2001), NO2, or CaO (Borovička & Koten

2003). These observations generally apply to Type I trains. Fainter

Type II parts of trains may be produced by other sources. Note

that train temperatures were directly measured by a Na lidar

resulting in temperatures up to 270 K, which was 60 K above

the ambient atmosphere (Chu et al. 2000). Mid-infrared spectroscopy

of persistent trains showed the emissions of heated CH4, CO,

CO2, and H2O; species that pre-existed in the atmosphere (Russell

et al. 2000).

There is a general agreement that the optical train luminosity

in the continuum phase is driven by exothermic chemical

reactions. The emission of FeO and other metal oxides is possible

after reactions involving ozone (Baggaley 1976c) or FeS (Murad

2001). NO2 emission is enabled by the reaction of O with NO,

either in clusters (Rajchl 1975) or on the surface of dust (Murad

2001). OH radiation can be produced after reaction of hydrogen

with ozone (e.g. Zinn et al. 1999). Various authors also discussed

reactions leading to the radiation of Na and O2. Recent observations

have, nevertheless, shown that these species are not major

contributors to the train luminosity in the continuum phase

(Borovička & Koten 2003, Clemesha et al. 2001).

In summary, though chemiluminescence is likely responsible

for train persistence, exact reactions and sources of radiation

have not yet been identified.

3.4 Reflection train

Trains somewhat similar in appearance to persistent trains can

be formed by the explosion of bright bolides in the atmosphere

during the daytime or during twilight. The significant difference

is that these trains are not self-luminous. They are visible thanks

to the reflection or scattering of sunlight on the dust particles

left in the train after the meteoroid disruption. Typical examples

are the dust clouds formed during the Tagish Lake (Brown et

al. 2000, see the title page of the issue) and Villalbeto de la Peña

(Trigo-Rodríguez et al. 2006) meteorite falls. Under favourable

circumstances, reflection trains can be visible for hours. They

may be formed at any height, depending on the dust deposition

by the fireball. Of course, more dust is produced by massive

objects and they often explode at a height around 30 km. The

observation of the Benešov fireball (Borovička & Spurný  1996)

showed that the cloud formed after fireball explosion at the

height of 24 km was self-luminous at the very beginning stage.

The cloud spectrum showed bright continuum superimposed

with bands of metal oxides (FeO, CaO, AlO, and MgO). The

continuum may be done by dust thermal radiation and the

oxide bands are possibly produced by the ozone reaction described

by Baggaley (1976c).
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Introduction

D
o you ever wonder how far away satellites are when you

spot them passing through your early evening (or early

morning) sky? Intuitively, the slower-moving ones must

be further away than the faster-moving ones. In fact, you can

go beyond intuition to determine the orbit height of a low-

Earth-orbiting (LEO) artificial satellite by using the satellite’s

apparent motion when it passes through or near your local

zenith.

The method described below takes advantage of the fact

that the satellite’s true velocity can be determined when it is

nearly overhead.

Preliminary

When you stand near (but not too near) a highway and look at

cars approaching, passing, and receding, you must have noticed

that a far-away car (approaching or receding) does not appear

to move very fast. Instead the car appears to move most rapidly

when it is just passing you.

What you are experiencing is a simple example of vectors.

The far-away car has a velocity vector that is directed mostly

toward (or away from) you, so you cannot see a lot of perpendicular

motion. When a car is at its closest and just passing you, its

velocity vector is exactly perpendicular to your line of sight and

what you see is the true velocity of the car and its fastest apparent

motion (Figure 1).

Now let us extend our point of view into space, and imagine

a set of satellites in increasingly distant orbits, as shown in

Figure 2. Obviously the farthest satellites will appear to move

slowest across the sky but we now have a more complicated

situation than our simple highway example. In this case, the

satellites are also moving at different orbit speeds.

The only parameter that we are able to directly measure

from our Earth-bound location is the apparent angular velocity

of the satellite. Apparent angular velocity is the apparent angle

traveled in a specific amount of time and is typically expressed

in degrees per second or radians per second. A radian is simply

another way of measuring angles. There are 2π radians (π �
3.14156) in a circle of 360° so that one radian is about 57.3°.

Equation 1 shows a well-known relationship between linear

and angular velocity:

Eq. 1

where ω = the apparent angular velocity (in radians/second);

v = the linear velocity; and

r = the distance from the observer to the moving object.

As the distance (r) increases, the apparent angular velocity (ω)

decreases, for the same linear velocity (v). 

� = v

r

Determining the Orbit Height of a Low-Earth-Orbiting Artificial
Satellite Observed near the Local Zenith
by Michael A. Earl, Ottawa Centre (mikeearl@castor2.ca)

Figure 1 — Apparent motion of an automobile as seen by an observer
at the side of the highway. When the car is far from the observer, its
velocity v is mainly pointed along the observer’s line of sight, and it
therefore appears to move more slowly. When the car is closest to the
observer, its velocity is perpendicular to the observer’s line of sight, and
it therefore is seen to move at its fastest rate.

Figure 2 — Four satellites in four different orbits seen by an observer
at the zenith. The observed angular velocities will depend on both the
satellites’ distances from the observer and the satellites’ linear velocities,
as stated in Equation 1.
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Theory

A watcher at point P on the Earth observes a satellite S passing

near his or her zenith, as illustrated in Figure 3. The observer

notes the apparent position of the satellite in the sky at two

specific times. By measuring the angle (θp) traced out by the

satellite in an elapsed time (∆t), the apparent angular velocity

(ωp) can be determined using Equation 2.

Eq. 2

where ωp = the angular velocity of the satellite as seen from

point P;

θp = the angle the satellite is observed to travel as seen

from point P; and

∆t = the elapsed time the satellite is seen to travel the

angle θp.

Using ωp for the angular velocity in Equation 1 and rearranging

its terms, we get:

Eq. 3

where h = the height of the satellite above the Earth’s surface

(Figure 4).

The height of the satellite (h) is the variable that needs to be

solved, but we require a value for v before the solution can be

found.

An orbiting satellite feels a gravitational force attracting

it to the centre of the Earth. Since that force is also centripetal

we can equate these two forces as demonstrated in Equation 4

in which the left side represents the centripetal force, and the

right, Newton’s Law of Gravitation. This relationship is true for

v hp= �

�p
t

=
θ p

�

all perfectly circular orbits:

Eq. 4

where m = the satellite’s mass;

G = the Gravitational Constant;

M = the Earth’s mass; and

rcs = the distance from the centre of the Earth to the

satellite.

Simplifying Equation 4 leads to Equation 5.

Eq. 5

Substituting for v (from Equation 3) in Equation 5 gives us

Equation 6:

Eq. 6

The distance rcs is not known. Since the satellite is near

the observer’s zenith, however, we can take advantage of the

fact that a line drawn from the centre of the Earth (c) to the

satellite (S) is co-located with the line drawn from the observer

(P) to the satellite as shown in Figure 4. From these circumstances,

we can write the simple relationship:

Eq. 7r r hcs cp= +

�p

cs

h
GM

r

2 2 =

v
GM

rcs

2 =

mv

r

GMm

rcs cs

2

2
=

Figure 3 — An observer at point P sees a satellite S passing near his/her
local zenith. He/she measures the apparent angle the satellite travels
between S1 and S2, and divides it by the elapsed time to determine the
apparent angular velocity.

Figure 4 — When observed at zenith, a satellite’s distance from an
observer P and its height above the Earth’s surface are identical. At
zenith, the distance of the satellite from the Earth’s centre C is the
addition of the orbit height and the Earth’s radius at the point P.
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where rcp = the distance from the centre of the Earth to the

observer.

Now we can substitute for rcs in Equation 6 to obtain Equation

8:

Eq. 8

So that:

Eq. 9

Finally,

Eq. 10

Equation 10 is a cubic equation (of the form Ax3 + Bx2 +

Cx + D = 0) and as a consequence there will be three unique

solutions for the satellite orbit height (h). Two of the three

solutions will be gibberish (which is slang for “not physically

possible”) and therefore can be ignored. The remaining solution

will be the correct and physically realistic one.

Solving a cubic equation from scratch is not fun. If you

thought the Quadratic Formula (that messy equation you learned,

or at least tried to learn, in high school) was bad, the Cubic

Formula is even worse. Fortunately, the Internet has cubic-

equation solvers that automatically determine the solutions for

you. See the References section to see the one that I used for

this article. In this example, the four coefficients for Equation

10 are:

A = 1;

B = rcp;

C = 0; and

D = -GM / ωp
2

When plugging in these values, make sure that the units are

correct. For rcp, I used kilometres, for G, km3/kg.s2, and for M,

kilograms, so that I got kilometres for the answer’s units. Don’t

forget the negative sign for the D coefficient either, or all three

solutions will be gibberish!

A Practical Example

This would be the end of the article, except we need to test out

theories using actual data before they can be taken as correct.

On the evening of February 11, 2006 I set up my CCD camera

in Ottawa, fitted with a 50-mm lens to point directly at my local

zenith.

From 7 p.m. to 9 p.m. E.S.T., the camera continuously

captured five-second exposures of my local zenith (yes, the sky

h r h
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was clear). About 1500 images were collected in total. I sifted

through these images, 20 at a time, using blink-comparator

software to check for satellite streaks, finding 12 usable satellite

streaks of differing lengths, and therefore differing heights. One

of the 12 images is shown in Figure 5.

Example: SL-3 Rocket Body (#13771)

I used Figure 5 to determine the scale for all images obtained.

I selected 15 stars scattered throughout the image and plotted

actual angular separation (in arc-minutes) between the stars

vs. the separation in pixels on the image for all combinations

of two stars. I used a polynomial curve-fitting technique to find

the most accurate equation from the resultant graph. To make

a long story short, the resultant image-scale equation was

determined to be:

Eq. 11

where θp = the angular separation between two stars (in arc-

minutes); and

λ= the pixel separation between the same two stars (in

pixels).

The example’s streak length was measured to be about 165

pixels. Using Equation 11, this streak length corresponded to

an angle of 3.63 degrees, or 0.0634 radians. The exposure time

was five seconds, which made the measured apparent angular

velocity (ωp) of the satellite 0.01267 radians per second.

For the same image in Figure  5, the coefficients of Equation 10

were determined to be:

A = 1;

B = 6367.313 km;

C = 0; and

D = -2.481602 × 109 km3.

θ p = − × + × + +− −( ) ( ) . .3 10 3 10 1 3154 0 27838 3 5 2� � �

Figure 5 — An image of a Russian SL-3 rocket body (#13771) captured
by my ST-9XE’s CCD camera while pointed at my local zenith at 23:48:45
UTC on February 11, 2006. The location of my local zenith at that time
is denoted by the large red cross. The image field of view is about 11.2
× 11.2 degrees. North is at top, east is at left. The exposure time was
five seconds.
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The value of rcp (the B coefficient) was taken from my

JRASC article (Earl 2005) concerning the determination of the

range of a satellite using a trigonometric parallax technique.

This value can also be calculated from the Web, where equations

for the radius of the Earth as a function of latitude can be found.

The D coefficient was found by determining the value for ωp

from the measured streak length and exposure time, as described

in Equation 2 and Equation 11, and using a Gravitational Constant

(G) of 6.6742x10-20 km3/kg.s2 and an Earth mass of 5.9742x1024

kg.

For this example, the three solutions to Equation 10 using

the coefficients above were:

1)  597 km;

2) -6305 km; and

3) -659 km.

Solutions 2 and 3 are physically impossible, since they

imply that the satellite orbited beneath the Earth’s surface.

Solution 1 indicates that the satellite orbits above the Earth’s

surface at a height of about 597 km, which is definitely possible

for a LEO satellite.

Additional Measurements

Using this method on all the satellites I captured on that night,

I tabulated the results (Table 1) in order of ascending orbit

height to study the error behaviour with respect to decreasing

streak length (increasing orbit height).

Conclusions

The technique I have outlined is indeed capable of determining

the orbit altitude of the low-Earth-orbiting satellites. Nevertheless,

there are several error characteristics that suggest a more in-

depth investigation would prove fruitful. Examination of Table

1 shows the shorter streak lengths are correlated with larger

errors in the calculated satellite altitude. The source of this

behaviour may be partly due to the derivation of the image scale.

Angular separations of 50 pixels and larger were used to solve

the image scale and so Equation 11 might be biased against

smaller angular separations and therefore smaller streak lengths.

Re-determining the image-scale equation using smaller angular

separations between calibration stars, using a larger number

of stars, using a CCD with a higher resolution, and/or increasing

the exposure time for the lower apparent-angular-velocity

satellites might improve the results.

No satellite that orbits the Earth has a perfectly circular

orbit, but LEO satellites have smaller orbit eccentricities than

their high-altitude counterparts. In summary, higher orbit

altitudes means a larger range of possible orbital eccentricities.

The small five-second exposure time I used ensured that the

height of the satellites would not change appreciably during

the exposure time. While the height might be determined

relatively accurately, the assumption of a circular orbit could

result in a larger error in the determination of the orbit period.

The zenith angle of the satellite might also impose a

noticeable effect. Those satellites that appear at the far edges

of the image might have a noticeably larger height error than

those nearer the centre (zenith). In the 11.2 × 11.2 degree field

ID STREAK STREAK D COEFFICIENT HEIGHT TRUE PERIOD TRUE

LENGTH LENGTH (GM / ωp2 ) (km) HEIGHT (min) PERIOD 

(pixels) (radians) (km) (min)

12465 177.912900 0.013677 -2.130869E+09 555 547 95.57 95.76

25527 169.434353 0.013024 -2.349776E+09 582 583 96.01 96.20

13771 164.878743 0.012673 -2.481590E+09 597 585 96.39 95.95

27840 123.328829 0.009477 -4.437512E+09 788 788 100.34 100.11

24968 120.503112 0.009260 -4.648144E+09 805 784 100.76 100.40

11111 113.216607 0.008700 -5.265847E+09 854 796 101.78 100.45

27433 105.304321 0.008092 -6.086907E+09 914 871 103.09 102.11

06154 94.810337 0.007286 -7.508461E+09 1009 953 105.07 104.53

25963 60.415230 0.004646 -1.846902E+10 1529 1418 116.40 114.08

25162 58.830264 0.004524 -1.947516E+10 1567 1471 117.21 115.23

09063 56.859948 0.004373 -2.084474E+10 1616 1499 118.30 115.17

25746 25.553865 0.001973 -1.024068E+11 3261 3013 156.71 148.48

Table 1: The calculated orbit heights of 12 LEO satellites imaged in Ottawa, Ontario on February 11, 2006, using an exposure time of 5 seconds.
Satellites were identified and orbit heights extracted using the satellite orbit propagator from Software Bisque’s TheSky (level IV, version 5); the true
period was obtained by taking the reciprocal of the mean-motion value of the satellites’ orbit elements.
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of view of the images, satellites can be detected as far as six

degrees from the zenith at the image corners.

Although increasing the exposure time to larger than five

seconds might help to reduce the height-determination error,

it might cause imaging difficulties. In order to determine the

angular velocity of the satellite, both endpoints of the streak

have to be present. If the exposure time is greater than five

seconds, many of the lowest orbit satellites would be able to

pass outside the FOV during the exposure time, thereby causing

a streak with only one (or no) endpoints. Background noise

increases with larger exposure times, such that the signal-to-

noise ratio of the satellite streaks would be reduced, since the

satellites are moving across the image with the same signal,

while the background noise accumulates on every pixel of the

image.

When all is said and done, this method is very accurate

for the lower-orbiting LEO satellites (200-km to 800-km orbit

heights), and this accuracy can be increased for the higher-

orbiting LEO satellites (800-km to 4000-km orbit heights) when

required, as long as the potential pitfalls are appreciated

beforehand.
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1. Introduction

O
ver the last several centuries, there has been a lot of

confusion about the relation between astronomy and

astrology. In this article, I will describe some observations

concerning this interesting juxtaposition of human knowledge

and creativity.

Any article that has the temerity to discuss astronomy

with astrology is going to encounter a lot of reader preconceptions,

so I will go very carefully. These preconceptions arise because

most people have strong feelings toward this meeting of worlds.

Let me start by affirming that I have positive views for both

sides.

I might begin with a legal case I ran into when I was a law

student. In the British casebooks there was, some sixty years

ago, a case where a young lady was suing a gentleman for

seduction using dishonest means. Apparently, in Brighton, a

young man was dating a young lady who incautiously mentioned

that she firmly believed in astrology. He held back the fact that

he wrote the local newspaper’s astrology column. As one might

expect, he inserted the admonition to “throw caution to the

winds” at just the right time, with predictable consequences.

My point with this vignette is to underscore the most

important aspect of astrology, that it is akin to religion for some

people, and one does not pontificate in this area lightly without

incurring the wrath of many readers.

To balance things, let me mention another vignette. I was

walking along an ocean beach once with a person who was very

skeptical of astrology, and he emphasized the impossibility, to

his mind, of action at a distance. He seemed to be rather

knowledgeable about tides, so I got him to agree about the

influence of the Moon on the Earth’s surface water. Then I

mentioned the unusually high and low tides, and he had to

agree that the Sun’s position could be considered the cause of

these extra large swings in the magnitude of the tides. I then

ventured the opinion that perhaps humans, who are to a large

proportion made of water, might somehow be affected as well.

He said that a car driving near you has much more gravitational

effect than distant bodies. I pointed out that more than gravity

is implied by the believers in astrology — think of “the music

of the spheres.” We will return to another effect of the Sun,

Moon, and planets shortly.

2. Precession and Ophiuchus

One of the strong tenets of astrology is that the exact positions

of heavenly bodies of the Solar System with respect to the celestial

Astronomy and Astrology
by Roy Swanson, Mississauga Centre (swanee@direct.com)

background significantly influence your destiny and portentous

inferences are made on that basis. Thus if you state in a horoscope

that the position of a heavenly body at a given significant time,

such as at birth, provides an indication of what lies ahead in

your destiny, the mere divulgence of the position lends an

authenticity to what is then surmised. In The Mikado, Poo-Bah

calls this strategy the addition of “...corroborative detail, intended

to give...verisimilitude to an otherwise...unconvincing narrative.”

(Gilbert & Sullivan 1885)

As an amateur astronomer, I find that there are two main

points about these two disciplines that require discussion: the

precession of the Earth’s axis of rotation, and the existence of

a thirteenth constellation in the zodiac.

2.1 Precession

First I want to begin with the Earth’s dynamics in the Solar

System. It is very much like a spinning top, with extra mass at

the equator. The spin axis is tilted 23.5 degrees to the plane of

the ecliptic. Now a spinning top will gyrate, or “precess,” unless

it is perfectly homogeneous and not affected by nearby objects.

Since the Earth has an equatorial bulge, and has large gravitationally

interacting bodies like the Moon and Sun relatively nearby, its

axis wanders around in a circle. If there were a pencil sticking

out of the top, it would point to different positions at different

times, moving smoothly around, and repeating the cycle after

a lot of spins.

The Earth precesses in a 25,800-year cycle. The northern

extension of its axis is presently pointing very near Polaris, but

the axis is always moving, and one day in the future, it will no

longer be pointing near Polaris. The Starry Night Pro software

package has a very interesting subroutine that shows the

wandering of the celestial pole over this 25,800-year period. The

Right Ascension (RA) of all the stars shifts due to precession,

but the plane of the ecliptic does not change. Without applying

a correction, key times in the seasons on Earth would change.

Two thousand years ago, the spring equinox occurred when the

celestial equator intersected the zodiac in the constellation

Aries (first point of Aries). Our calendar is very deliberately

altered with leap years, and earlier, even more drastic measures,

to make sure that the spring equinox stays relatively put. At the

present time, this important first seasonal point occurs with

the celestial equator intersecting the zodiac near the Circlet in

Pisces.

This process means that the positions of the Sun and

planets as observed from the Earth are not time-invariant, as

astrology assumes, but are really (slowly but continuously) time-

mailto:swanee@direct.com
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dependent. We call the current time interval an “epoch” in this

long cycle of precession. An epoch is many hundreds of years

in duration. It is actually very difficult to define an epoch, since

it must refer, in the end, to time between inadmissible variances

from a reference position, in a smoothly changing phenomenon.

It is similar to replacing a smooth curve with a bar chart.

I suspect that astrologers came adrift with the problem of

a suitable epoch before they finally gave up trying to relate

properly to astronomy. They want timeless immutable positions

for the solar bodies.

If we consider the zodiac as composed of twelve equal-

sized constellations (as astrologers still do), then the vernal

(March) equinox moves through the constellations at a rate of

one every 2150 years. This shift amounts to about one hour of

RA every millennium.

The problem is that in stating the positions of these heavenly

bodies, most astrologers are at least one epoch back! As a result,

the positions they use are nearly always very wrong. One can

imagine a crusty farmer in the Middle Ages (in the northern

hemisphere) saying to an astrologer, “you can believe what you

want, but I am not planting crops until one week after spring

equinox.”

2.2 Ophiuchus

The zodiac refers to those constellations that lie along the plane

of the ecliptic (i.e. the plane of the Solar System). The Sun appears

to move smoothly to the east through the zodiac constellations

as the year goes by. The modern boundaries of the constellations

were set down in 1919. Since at least that time, it has been agreed

that the constellation of the Snake Bearer, Ophiuchus, has part

of his domain in the plane of the zodiac, taking away regions

considered by the astrologers as part of the Scorpion (Figure

1). Stars very close to the ecliptic in this area, such as Theta

Ophiuchi, have been considered part of Ophiuchus for many

centuries, since Ptolemy at least. The problem is therefore that

there are thirteen constellations in the zodiac, not twelve.

An unlucky number indeed.

There is a great deal of beauty in the number twelve. It

applies to a lot of things; a dozen, or the formal number of

persons in a jury deciding your fate, for instance. It can be

divided by 1, 2, 3, 4, 6, and 12, and it divides a circle of 360 degrees

neatly by 30.

The problem is what to do about Ophiuchus? Astrologers

simply ignore its existence, now and in the past. It does, however,

emphasize the arbitrary nature of constellation boundaries,

now and in the past.

3. The Sun in the Thirteen Constellations of the Zodiac

Pick up any newspaper article on horoscopes and the twelve

constellations are, for all time, the “houses” as shown in the

right hand side of Table 1.

The boundary days or “cusps” differ slightly in different

listings of this table. Astronomically speaking, however, the

correct positions of the Sun are as noted in the left-hand columns

of the table. You may wish to check your own “sign” to see where

you would fit in the modern scheme of things. A “Cancer,” born

on June 30, would actually find that the Sun was in Gemini on

that date. Your chance of similarly being off by one sign is nearly

90 percent and growing.

The problem and the irony lie in the need in astrology to

know the exact position of the Sun relative to a constellation

at key times, such as at a person’s birth. Since it is both fruitless

(and dangerous) to look at where the Sun is with the naked eye

or unprotected optics, the public accepts the word of the

astrologers when they state where the Sun is located with respect

to these background zodiac constellations (often referred to as

“houses”). They also take the word of the astrologer for the

positions of all the other major bodies of the Solar System, which

suffer from a similar deficiency in reality.

However, with the recent advent of astronomical software

such as Starry Night Pro, it is very easy to check the Sun’s location,

simply by removing the glare in the computer simulation. I have

also found the programs helpful in planning what to look at,

and where, before an evening of stargazing. I have been in email

contact with the two local astrologers who write columns for

the Toronto Star and the Globe and Mail newspapers. Aside

from sniffing that I must be an Ophiuchan (which I am), they

have never denied my numerous assertions as to where the

(Solar System) heavenly bodies really are, compared to where

they say they are.

It is instructive to take a program like Starry Night Pro

and step the time back to noon on the same day one century

Figure 1— The sky for January 1, 2007, with the Sun and Mars in
Ophiuchus. The other nearby planets have all recently passed through
Ophiuchus.
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earlier, then two centuries, and so on. Examples of this exercise

are given in Appendix A. One then finds that the astrologers

are often correct if the person was born, say, at that time about

2000 years ago. Yet, ironically, great significance is placed on

these “exact” positions. Further, the temperament of the person

of a given sign of the zodiac is also affected by the entry of a

planet into that house. Many books and Internet sites describe

the personalities assigned to these bodies. These are also badly

out of position.

4. Final Remarks

Time is running out for astrology for two reasons:

1) the continuing effect of precession means that the gap

between the fixed astrological table and the current

astrometrical tables will continue to widen even more

glaringly over the years. As Appendix A shows, the

tables of antiquity became inaccurate shortly after the

birth of Christ.

2) more and more members of the public are becoming

computer literate, and excellent planetarium programs

are becoming very popular.

Let me explain what I am getting at here. There are two aspects

to the belief in astrology in my opinion. The first is the world

of fantasy about heavenly bodies imbued with all sorts of human

traits. To me this is an indulgence between consenting adults,

and will be with us for a long time. You get nowhere using

rhetoric to discredit that. The second is the stating of the position

of these heavenly bodies. I think that astrologers should be liable

for legal action — civil lawsuits — when they misrepresent the

solar and planetary positions and take money for their statements.

Sooner or later, a brave astrologer will break from the fold, and

be the first of a new wave of 21st-century astrologers to make

two major steps:

1) align all positions of the Solar System bodies with the

actual positions as indicated by astronomy for the

present epoch, and allow for future shifts, and

2) admit Ophiuchus into the houses of the zodiac.

These steps would not affect what is already written for the

heavenly bodies in themselves. Unfortunately, in astrology, there

is a tremendous amount of vested interest in preserving the

past. If people who spend money on horoscopes wake up and

sue the astrologers, there will be a very exciting time. I am

nevertheless hopeful. I think it is fun to get up in the morning

and read a heartening set of words to use for that day, regardless

of their veracity. After all, having a doctorate in stochastic

(random) processes, I know that every once in a while the

comments will be “right on.”
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Astronomical Position of the Sun Astrological Position of the Sun

Aries April 18 - May 13 Aries March 21 - April 20

Taurus May 13 - June 21 Taurus April 21 - May 20

Gemini June 21 - July 20 Gemini May 21 - June 21

Cancer July 20 - August 10 Cancer June 22 - July 22

Leo August 10 - September 16 Leo July 23 - August 22

Virgo September 16 - October 30 Virgo August 23 - September 22

Libra October 30 - November 23 Libra September 23 - October 23

Scorpius November 23 - November 29 Scorpius October 24 - November 22

Ophiuchus November 29 - December 17

Sagittarius December 17 - January 20 Sagittarius November 23 - December 17

Capricornus January 20 - February 16 Capricornus December 22 - January 20

Aquarius February 16 - March 11 Aquarius January 21 - February 19

Pisces March 11 - April 18 Pisces February 20 - March 20

Table 1. The Sun in the Zodiac according to Astronomy and Astrology
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Appendix A

The following examples underscore the assertion that the

positions stated are certainly not right for the present year:

Example 1. Astronomy Table: January 20, 2004, Sun is on border

between Sagittarius and Capricornus. Astrology Table: Sun is

between Capricornus and Aquarius at that time. So how far

back in time must we go to get the Sun on the border between

Capricornus and Aquarius on January 20? The year 75 BC,

according to Starry Night Pro.

Example 2. “Scorpio (Oct 24 - Nov 22): With Uranus now in

Pisces, the tide will move you forward.” (Toronto Star, Saturday,

January 3, 2004, Page L7). Starry Night Pro has Uranus at noon,

January 3, 2004 in Aquarius, 90% of the distance from the Piscean

border to the Capricornian border. Stepping back in time, I find

that at noon, January 3, 1935 Uranus was just inside the house

of Pisces near the Aquarius border.

Example 3. “Aquarius ( Jan 21 - Feb 19): Make the most of

Venus in your sign.” (Toronto Star, Sunday, January 4, 2004, Page

B5). Starry Night Pro has Venus in the middle of Capricornus

for that day. Venus was last in Aquarius on January 4, 2001, and

will appear there again in 2009.

Example 4. “Leo ( July 23 - Aug 22)...with Mars in Aries...”

(Toronto Star, January 6, 2004, Page C4). On this day, Mars is

half way along the west fish of Pisces, from the juncture to the

Circlet. The last time Mars was in Aries on January 6 was 1974.
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Introduction

A
total solar eclipse is perhaps the most spectacular of all

regularly occurring astronomical events that can be

viewed from Earth, and is relatively easy to photograph

compared to most other astronomical objects. The solar corona

and chromosphere are bright and large in apparent size, so they

can be photographed with short exposures and modest focal

lengths. On the other hand, while the human eye has sufficient

dynamic range to appreciate the corona’s great range of brightness,

the limited dynamic range of photographic media makes it

virtually impossible to record all of the corona’s detail in a single

exposure.

I used 31 exposures taken with a Nikon D70 digital SLR

camera through a Borg 77-mm f/6.5 ED refractor (focal length

500 mm) on a Kenko SkyMemo equatorial mount to photograph

the total eclipse from Egypt on March 29 of this year. The

exposures were taken in one-stop increments ranging from

1/2000 second to 1 second using a pre-scripted sequence in

ImagesPlus 2.75, a software package for DSLRs that allows

unattended operation of the camera. This allowed me to visually

observe the eclipse during the entire period of totality. ImagesPlus

saves the image files to the computer’s hard drive instead of to

the camera’s memory card, which requires download times of

several seconds for each exposure. Although images saved in

RAW format have a greater dynamic range than images saved

in JPEG format, I decided to save the images in JPEG format

because the smaller files and shorter download times allowed

me to take more exposures at each exposure setting.

Processing in Photoshop

Photographers using radial-density gradient filters and darkroom

techniques to combine multiple exposures were partially

successful in increasing the amount of coronal detail that could

be displayed in a single image, but it was the development of

digital-image-processing techniques in the 1990s using image-

editing software such as Adobe Photoshop that allowed the full

range of coronal detail to be displayed in a single image. A

successful and widely used technique was to combine multiple

exposures with Layer Masks as described by Russell Brown

[available by searching on the Web – ed.]. Although excellent

results can be obtained this way, creating the masks for each

layer involves a considerable amount of trial and error and is

labor-intensive and time-consuming.

The latest version of Adobe Photoshop, CS2, contains a

Creating a High-Dynamic-Range
Solar Eclipse Composite Image
by Alson Wong, (alsonwong@charter.net)

High Dynamic Range feature that creates a 32-bit image from

multiple exposures. I was able to obtain a superior result using

this technique compared to the result using Layer Masks, with

much less time and work invested. This feature may be accessed

in Adobe Bridge by selecting Tools > Photoshop > Merge to

HDR, but the preferred method is to access it in Photoshop by

selecting File > Automate > Merge to HDR, which brings up a

dialogue box for selecting the images to be used, and includes

an option for automatically aligning the images. The automatic

alignment feature can be very useful, as the motion of the lunar

disk between second and third contact can make it difficult to

properly align the individual exposures in order to preserve

coronal detail.

After the images have been selected for processing, select

OK to create the HDR image.

If scanned film images are being used, exposure information

must be manually entered for each image. If the exposures were

all taken at the same ISO and f-stop, then set the Exposure Value

(EV) to 0 for the exposure(s) in the middle of the exposure range,

with EV in increasing order for long exposures and decreasing

order for shorter exposures. The EV values should correspond

to f-stops, so if the exposures are in one-stop increments use

one-stop increments when setting the EV. If the exposures are

in two-stop increments use two-stop increments for the EV.

Exposures taken with a digital camera already contain this

Figure 1 — Selecting files to be merged into an HDR image

mailto:alsonwong@charter.net
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information, so the images will have an EV assigned automatically.

The HDR preview image is displayed in a window along

with thumbnails of the individual exposures on the left side

with their corresponding EV and check boxes that allow selection

and deselection of individual exposures. The right side of the

window displays a histogram with a slider for a white point

adjustment that allows previewing of different parts of the

brightness range of the HDR image, as computer monitors are

incapable of displaying the entire range at once. Adjusting the

White Point Preview will not alter the final HDR image. With

the bit depth set at 32 bits, select “OK” to create the HDR image

file and then save it as a Portable Bit Map file before proceeding

further. Creating the HDR image is very computer-intensive

and may consume a lot of computer time, depending on the

number and size of the image files used. About one hour of

computer time was required for my 1.8-GHz, 1-GB RAM desktop

to create the HDR image using the 31 JPEG images.

Most of Photoshop’s features are disabled in 32-bit mode, so

to process the image further, select Image > Mode > 16 Bits/Channel

to convert the image to a 16-bit image. This will bring up the HDR

Conversion dialog box, with four methods available. Local Adaptation

offers the most control. The Threshold and Radius sliders sharpen

the image; it may take several attempts with different settings to

determine the best combination of values to create a sharp image

without artifacts. The Toning Curve and Histogram adjust the

contrast of the image. The tick marks on the bottom represent f-

stops. Start by moving the left lower portion of the curve to a point

one or two tick marks to the left of the histogram — this sets the

black point. If necessary, adjust the right upper portion of the

curve so that it is one or two ticks to the right of the histogram.

Other points in the middle of the curve can be added to adjust

the contrast of the midtones. After completing adjustments, click

“OK” to convert the image to 16 bits.

The 16-bit image can now be processed with the full range

of tools in Photoshop CS2. If the image is not perfectly centred

in the frame, crop the image so that it is centred. Having the

image centred in the frame is important when creating a

sharpening layer, since an off-centre image will create more

artifacts. Select Layer > Duplicate Image to duplicate the image.

With the duplicate layer selected, apply a Radial Blur to the

image using Filter > Blur > Radial Blur. This brings up a dialog

box. Set Blur Method to Spin, and Quality to Best: values of 10

to 20 usually give the best results. Click “OK” to blur the duplicate

layer.

Next, select Image > Calculations, which brings up a dialog

box. For Source 1, set Layer to Background copy and Channel

Figure 2 — The HDR preview image

Figure 3 — Using Local Adaptation to convert from 32-bit to 16-bit
mode

Figure 4 — Applying a Radial Blur to a copy of the background image
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to Gray. For Source 2, set Layer to Background and Channel to

Gray. Set Blending to Subtract with an Opacity of 100%, Offset

of 128, and Scale of 1. Set Result to New Document and click

“OK.” This creates the sharpening image.

To apply the sharpening image, select the image using

Select > Select All, then select Edit > Copy and then click on

the original image and select Edit > Paste to add the sharpening

image as a new layer (Layer 1). Click on the eye icon next to the

Background copy layer to hide it. Next, click on the sharpening

layer (Layer 1) and change the blend mode by opening the drop-

down menu at the top of the Layers palette. Set the blend mode

to Overlay for a mild sharpening effect or Linear Light for a

stronger sharpening effect. The sharpening layer can also be

duplicated to strengthen the sharpening effect even further.

Motion of the lunar disk between exposures usually results

in some limb artifacts, as the individual exposures are aligned

on the corona. A slightly enlarged lunar disk image can be pasted

in as a layer to cover most of these artifacts. I chose to combine

my second-contact exposure (1/1000 second) and third-contact

exposure (1/2000 second) to feature prominences and chromosphere

on both sides. One image is pasted on top of the other. Using

the Move tool, the top layer is aligned with the background

layer. Zooming into 100% and setting the blend mode to Difference

can be useful when aligning the two layers. When the layers are

aligned, the blend mode is set to Lighten. In this example, since

the two layers are of different exposure length, the brightness

curve of the 1/1000-second exposure is adjusted to match the

extent of corona displayed in the 1/2000-second exposure, so

that the corona appears symmetrical on either side of the lunar

disk. After this has been done, the image is flattened using Layer

> Flatten Image.

In order for this image to cover the lunar disk and limb

artifacts in the composite image, it will need to be enlarged

slightly. To do this, select Image > Image Size and enter in a

new value in one of the dimensions that is 5-10% greater. Be

sure that the Constrain Proportions box is checked so that the

image is enlarged in both dimensions and click “OK.” To select

only the lunar disk, prominences, and chromosphere, click on

these portions of the image with the Magic Wand tool until you

are satisfied with the portion being selected.

Choose Edit > Copy and then paste this selection into the

composite image. Use the Move tool to align the lunar-disk

image layer with the rest of the composite image. It may take

a few attempts to find the optimum size for the lunar-disk image

that just barely covers the disk and limb artifacts in the composite

image while minimizing the amount of inner corona that is

Figure 5 — Creating the sharpening image

Figure 6 — Applying the sharpening layer

Figure 7 — Selecting the lunar disk and prominences with the Magic
Wand tool
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covered. If you need to try again, delete the lunar-disk layer and

resize the lunar-disk image that you created in the previous

step and repeat the selection process using the Magic Wand

tool.

In the example illustrated in Figure 8, there is an artifact

that extends an appreciable distance from the right side of the

lunar limb into the inner corona. I did not want to cover up this

portion so I left this to be removed later using the Healing Brush

tool.

Further adjustments to the background layer can be made,

such as contrast adjustments with Image > Adjustments >

Curves. Sharpening the image may have increased the noise, so

this can be reduced using Filter > Noise > Reduce Noise.

When the contrast and sharpness of the image have been

optimized, save the image in Photoshop (.PSD) format with the

layers intact so that additional processing can be performed

later if desired. Artifacts in the image such as the one in the

inner corona and defects such as dust spots are most easily

removed after flattening the layers. Before flattening the layers,

be sure that the Background copy layer is hidden (indicated by

an absent eye icon next to the layer), so that it is discarded when

the image is flattened. The defects may then be removed with

the Healing Brush tool and the final version saved.

When done properly, this process results in an image that

captures the full range of the corona’s brightness, resembling

its spectacular visual appearance.

Alson Wong is an amateur astronomer based in Southern California

and is a member of the Riverside Astronomical Society. He has

observed and imaged six total solar eclipses (1995, 1999, 2001, 2002,

2003, & 2006). By day, and often at night, he is a pediatrician with

the Southern California Permanente Medical Group.

Figure 8 — Lunar limb artifact extending into the corona

Figure 9 — the final image.
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T
he increasing availability and use of electric light at night

to improve visibility has brought about a profound

transformation of human existence in a little over a

century. Activities such as work, recreation, and travel are far

less limited than when candles and gaslights were the main

ways of overcoming natural darkness. The benefits are considerable.

Copious artificial light certainly decreases the fear of crime1,

which leads people to think that light also discourages actual

crime. Retailers know that bright lighting attracts customers.

Politicians encourage the proliferation of lighting to give an

impression of prosperity and security. Road-safety authorities

believe that increased road lighting reduces the rate of accidents

at night. Fossil-fuelled power stations are more efficient and

hence more profitable when the base (night) load is kept high,

so lighting is encouraged by lower prices for the electricity used.

Commercial and decorative illumination tends to be competitive

in quantity. Religions tend to associate darkness with evil and

light with goodness, thereby reinforcing the notion that more

light is a good thing.

It is not surprising that satellite imagery of Earth at night

indicates worldwide trends for more and brighter artificial

lighting. Generally, city lighting is becoming brighter and

extending further into the surrounding countryside in the UK2

and other countries. It seems that there is a great deal of scope

for this to continue, insofar as many inhabited areas are still

unlit at night and most of the areas that are lit are not yet

illuminated to daylight levels.

Ophthalmic practitioners doubtless see more lights and

brighter illumination as beneficial for visual performance at

night. Can we have too much of this good thing? Is artificial

light an almost boundless boon, or are there adverse factors

that need to be taken into account?

It would help to know something about the amounts of

light in question. The total artificial-light flux emitted by a city

is proportional to the product of two quantities: the number of

light sources and their mean output of light. Both of these

quantities are typically increasing over time in cities. This

suggests exponential growth in the total flux. The same result

can be reached by considering the increasing amount of light

used per person and the growth in population. Exponential

growth cannot be sustained indefinitely. There are practical

limits set by costs and finite resources and ultimately by visual

intolerance to excessively bright ambient illumination.

In outdoor situations, such as key areas in retail precincts

and sports arenas lit for television broadcasting, illuminances

of over 1000 lux are routinely achieved at night. Although this

is well into the daylight range, it is still a log unit or more short

of allowing optimal visual performance. On the other hand, it

is also about four log units brighter than strong moonlight and

seven log units brighter than natural dark conditions in the

open. This capability in lighting practice is sufficient to allow

a useful degree of supplementary lighting to be provided outdoors,

as desired during daylight hours when natural illumination is

reduced by low solar altitude, weather, and shadowing/shielding

effects of the built environment and terrain.

The growth in ambient artificial light at night over the

past century represents a massive environmental change. In

general, outdoor luminaires emit some or even most of their

light above the horizontal and some of the downwardly directed

light is reflected upwards by the terrain. Typically, about one

third of all outdoor artificial light ends up travelling above the

horizontal, heading for outer space. This mixture of unused

and waste light is one form of light pollution. A tiny fraction of

it is backscattered towards the ground by air molecules and

suspended matter. This is seen as artificial sky glow, which adds

to the faint natural sky light emitted mainly by oxygen in the

upper atmosphere.

Major astronomical observatories were built originally in

or close to large cities — for example, Paris, Greenwich, Melbourne,

and Mount Wilson — but, within a few decades of the introduction

of electric light in the 1880s, the accompanying artificial sky

glow was seriously diminishing the visibility of faint celestial

objects. This made city locations unsuitable for professional

astronomical research. Newer observatories were built further

away. Ironically, the presence of these observatories and the

roads to them has tended to foster the establishment and growth

of local towns along with their light pollution.

Increasing concern about light pollution as an astronomical

problem led to the formation of the International Dark Sky

Association in 19873. Currently, it has more than 10,000 members.

Is Artificial Light at Night Too Much
of a Good Thing?
Barry A.J. Clark, B.Sc., M.App.Sc., Ph.D., Dip.Mech.E.

Director, Outdoor Lighting Improvement Section, Astronomical Society of Victoria Inc.

Reprinted with permission from Clinical and Experimental Optometry (Clin. Exp. Optom. 2005; 88; 4; 197-199).
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Most are professional or amateur astronomers, and the others

include environmentalists, ecologists, lighting people, and

bushwalkers. The IDA has tried hard to get the lighting industry

on side and has succeeded to the extent that the industry funds

IDA activities such as seminars, while increasing use is being

made of luminaires of the full-cutoff type, which have reduced

intensity near the horizontal and no light emission above it.

A genuine solution of the light-pollution problem requires

more than better luminaires: substantial reductions are necessary

in the total emitted light flux. Billboard, decorative, commercial,

domestic, roadway, and landscape lighting are burgeoning

regardless, so it is hardly surprising that public debate on the

issues has become increasingly polemic in recent years.

The growth in artificial sky glow is an approximate but

nonetheless valuable indication of the growth of energy use for

outdoor lighting. Accurate direct measurement of night-sky

luminance generally requires costly equipment but sky luminance

can be estimated from observation of faint stars4 or by counts

of stars in the visible hemisphere or in a part of it marked by

bright stars. In natural dark-sky conditions, about 2700 stars

are detectable in the sky hemisphere without optical aid. In the

middle suburbs of Melbourne, for example, in which the total

population is 3.5 million, only two to three per cent of the 2700

stars are now visible and the sky is often bright enough to show

a dark blue colour, that is, within the range of sensitivity of

retinal cones. As in other large cities in the Southern Hemisphere,

the fifth star of the Southern Cross is often invisible and the

fourth star is becoming harder to see.

In Melbourne the observed rate of increase of sky luminance

is doubling every decade5, which is more than 20 times the

relatively generous growth rate for greenhouse gases requested

by Australia and agreed to in the Kyoto Protocol but not yet

ratified. Artificial sky glow causes great aesthetic losses in our

natural heritage and affects the education of schoolchildren6.

There has been little community concern about this, possibly

because the loss has been so gradual. It brings to mind the

proverbial frog in hot water being unaware of danger when the

rise in temperature is imperceptibly slow. Light pollution is

increasingly hampering astronomical research. This is of great

practical concern as astronomy is one of the main wellsprings

of intellectual, scientific, and technological progress.

Exposure to artificial light at night appears to have a large

range of generally adverse effects on animals and plants7 and

has led to coining of the term “ecological light pollution” as

something akin to but generally different from astronomical

light pollution. Mammals tend to exhibit circannual periodicity

in aspects such as amount of body fat and reproductive behaviour.

These variations are known to be responses to seasonal changes

in the length of daylight8.

Some endocrine functions in humans are susceptible to

interference by excessive exposure to artificial light at night,

for example, from night shifts, long hours of watching television,

brighter indoor lighting, and possibly stray light leaking into

bedrooms. The consequences apparently include increased

incidence of breast and colorectal cancer9, overeating, and

obesity-related medical conditions. Light leakage into bedrooms

can also cause sleep disruption and sleep loss. Inadequate sleep

can result in daytime fatigue and sleepiness. Drowsiness

contributes to causation in up to 20 percent of traffic and

industrial accidents10-12.

Reasons for reducing light pollution include the above and

many others. Practical ways of minimizing lighting excesses

and obtrusiveness without compromising mobility safety do

exist. In fact, reduced glare is often a most useful outcome.

Many governments have already introduced legislation to control

light pollution and light trespass; however, achieving the overall

improvement required has been greatly impeded by the belief

that outdoor lighting prevents crime.

Despite the efforts of a few criminologists who claim to

have evidence for a beneficial effect of increased light13, there

is much stronger evidence for an adverse effect. Crime is typically

reduced during lighting blackouts. For example, crime dropped

dramatically across the whole area of the blackout that affected

50 million people in North America in August 2003. Earlier, an

official report described how crime increased by 21 percent

when Chicago’s alleyways were given a four-fold increase in light

as a supposed crime-prevention strategy14.

This editorial is a somewhat unexpected outcome of the

writer’s concern that high-intensity, low-mounted, upwardly

aimed decorative floodlamps could be an ocular hazard to

children and others attracted to stare into the lamps at close

range. Complaints to one authority about children observed to

be doing this at the former Melbourne Observatory were dismissed

with a statement that it was purely an issue of parental control.

A municipal council referred a complaint about similar incidents

in a public park to Professor Barry Cole. Our respective assessments

of the degree of hazard differed, so Professor Cole invited

acknowledged expert Dr. J.J. (Hans) Vos to review the subject.

Dr. Vos graciously agreed and his review appears in this issue

of Clinical and Experimental Optometry.

To date, lighting standards have largely been developed

by lighting professionals and others from the lighting industry.

Accordingly, the standards hardly skimp on the minimum light

levels recommended and tend to favour continuation of established

practices in the face of research results about obtrusiveness,

unsustainability, and adverse ecological effects. There is a

pressing need for vision scientists and ophthalmic practitioners

to pursue a much more active role in researching the issues and

ensuring that lighting standards take due account of the results.

A balanced assessment of the benefits and disadvantages of

light at night should go well beyond the degree to which it assists

the ability to see. The many compromises that set outdoor-

lighting practices will need to be rethought accordingly. Increased

participation of vision experts in the setting and evolution of

lighting standards would help optimize the practical benefits

of night lighting within the severe environmental constraints

that appear inevitable. Not the least difficulty in bringing this

about will be the known reluctance of existing lighting-standards
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committees in several countries to provide places for experts

from outside the lighting industry.
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Second Light

T
he Kuiper (pronounced “kwiper”) Belt is a collection of

rocky-icy bodies beyond the orbit of Neptune. Pluto and

its moon Charon are part of the Kuiper Belt, and there

are several other bodies whose sizes are comparable to, or even

larger than, Pluto. About a thousand such bodies are known,

but there must be many more that are too small to see directly,

because in any population of bodies that collide with each other

the number in each size range rises approximately as the inverse

cube of the diameter. For example, 100-km bodies are about a

thousand times more numerous than 1000-km bodies. Extrapolating

that to 100-m-sized bodies predicts about 1014 of them. But the

only practical way to “see” such small bodies is through stellar

occultations. Several projects are underway using optical

telescopes, but a very interesting approach by Hsiang-Kuang

Chang of the National Tsing Hua University in Taiwan uses X-

ray occultation and recently reported 58 events (see the August

10, 2006 issue of Nature).

Chang used data from the orbiting Rossi X-ray Timing

Explorer, with Scorpius X-1 as the background source. It is the

brightest X-ray source outside the Solar System and conveniently

lies just six degrees away from the ecliptic. Even so, there were

numerous technical difficulties that Chang had to overcome,

including the lack of photons and deciding whether the observed

dips arose from something at the source or an instrumental

effect. He took all of the observations of Sco X-1 by RXTE over

the period from 1996 to 2002, with a total exposure time of

322,000 seconds, and found that there was an excess of “dips”

in the X-ray flux, with most events lasting two to three milliseconds

(the longest is seven milliseconds). The occurrence times of the

dips in X-rays are random. While Sco X-1 is known to flare on

millisecond timescales, dips were hitherto unknown. When

Chang looked at the Crab Nebula he saw no dips. Because the

Crab is an extended source, there should be no small fluctuations:

their absence implies that the dips for Sco X-1 are not an

instrumental effect. This leaves occultation by Solar System

objects as the most plausible explanation.

One problem with this result is that Chang’s estimate of

the number of bodies in the 10 to 100-metre-size range is ~1015,

far more than the ~1012 suggested by computer models of the

collisional evolution of the Kuiper Belt. This could be due to a

lower average collision rate between the bodies than assumed

by the models, or (Chang suggests) it might indicate the presence

of another component of smaller KBOs at distances greater

than the generally assumed 50-AU cut-off for the Kuiper Belt.

Two other groups are looking for Kuiper Belt occultations

in the optical range. One, led by Françoise Roques of the

Observatoire de Paris, has a paper in press with the Astronomical

Journal reporting the detection of three objects with sizes ranging

from 220 to 600 m. They used a clever technique at the William

Herschel telescope on La Palma, in the Canary Islands. The

smallest of the three appears to be in an orbit between Saturn

and Uranus, while the other two are much further away from

the Sun than usual for the Kuiper Belt (140 and 210 AU). They

comment that finding these two objects suggests a large population

of small bodies in the “outer solar disk,” and first suggested this

at the annual meeting of the Division of Planetary Sciences (of

the American Astronomical Society) in Louisville two years ago.

The third group is the Taiwanese American Occultation

Survey (TAOS), which uses four telescopes to weed out “false

positives” arising from variations in the star’s brightness. The

four telescopes are installed in the mountains of a national park

in central Taiwan.

They have not yet reported any detections of unexpected

occultations, but they have seen occultations coming from

known asteroids. The project is a multi-year automated survey

of ~3000 stars.

It is worth emphasizing again that occultations are the

only way to find objects this small in the Kuiper Belt. Even the

largest telescopes struggle to find KBOs much larger (in the

1000-km-size range), though the hope is that, after finding some

through occultations, follow-up observations with a 10-m-class

telescope will be able to locate the ones that are larger than

about 25 km. The field of view of the Keck telescopes is just 37

arcseconds, however, so the follow-up observations must be

done quickly. No telescope currently under consideration could

ever detect objects as small as those found by Chang and Roques.

With all the work being done on high-redshift galaxies

and investigations of the Big Bang, it is a little disconcerting to

realize that we have not yet completed the inventory of our own

Solar System!

Leslie J. Sage is Senior Editor, Physical Science (Astronomy), for Nature

Magazine and a Research Associate in the Astronomy Department

at the University of Maryland. He grew up in Burlington, Ontario,

where even the bright lights of Toronto did not dim his enthusiasm

for astronomy. Currently he studies molecular gas and star formation

in galaxies, particularly interacting ones, but is not above looking at

a humble planetary object.

Small Kuiper Belt Bodies Seen by X-ray Occultation
by Leslie J. Sage (l.sage@naturedc.com)

mailto:sage@naturedc.com
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I
n this ever-changing world, where governments, countries,

and regimes hyperactively flit across the world stage, you

can normally turn to the deep sky if you want constancy.

Ignoring notable transient exceptions that include novae,

supernovae, and variable stars, the galaxies and clusters we

gaze at today through our telescopes will look no different to

future generations of RASC Journal readers for the foreseeable

future. However, if you were Methuselah and wanted to see

changes in a deep-sky object, your best bet would be to look at

the more dynamic ones, i.e. open clusters and nebulae, where

changes readily occur on a scale of a few million years or less.

In contrast, the average globular cluster has a disruption time

of about 30-billion years. Of course, there are exceptions to the

rule of longevity for globular clusters. One such exception is

NGC 288, an easily seen globular cluster in Sculptor (RA(2000)

= 00h 52.8m, DEC(2000) = -26° 35´). At a distance of about 30,000

light years, it has a diameter of 13´ and a magnitude of 8.1,

containing about 100,000 stars. It is visible in binoculars from

southern latitudes, but benefits from aperture here in the

northern latitudes where its low altitude results in dimming

due to atmospheric extinction.

Compared to most other globular clusters, NGC 288 has

a terminal sentence, being expected to dissolve within the next

billion years or so. Its early demise will be the logical consequence

of its frequent flirtations with the galactic centre. Indeed, every

200 million years or so, its orbit takes it within 5000 light years

of the centre of our Galaxy on a path inclined at 47° from the

Galactic plane. At the moment it is being coy, lying at its

apogalactic point about 35,000 light years from the galactic

centre and nearly directly below us from the galactic plane.

However, it will soon return on a kamikaze brush with tidal

forces deep within the bulge of our galaxy, flinging off stars in

a process where pairs of stars duel each other in a slingshot

manner that ejects one from the pair and sends the other closer

to the core of the cluster. As it navigates the crowded interior

of our galaxy, each such flirtation speeds NGC 288 on its way

to tenuous oblivion. Don’t feel sorry for this cluster, though,

since it has already had been in existence for more than twice

as long as the Earth.

Despite its somewhat short life expectancy on cosmic time

scales, NGC 288 is of course unchanging when viewed by us

mortals. Indeed, if you observe this cluster you will see exactly

what William Herschel saw on that autumn night 221 years ago

(October 27, 1785) when he was the first-ever human to view

this object.

If you decide to observe NGC 288, you absolutely must

swing your scope 1° 45´ NW and have a peek at the Sculptor

Galaxy, NCG 253 (RA(2000) = 00h 47.6m, DEC(2000) = -25° 17´),

aptly called the Silver Coin by some. At latitudes where this

galaxy rises well above the murky horizon, it is one of the

highlights of the night sky, shining nearly edge-on, big and

beautiful just as its colloquial name suggests. With a magnitude

of 7.2, and apparent size of 26.4´ × 6.0´, the beauty of this galaxy

hides a violent side — it is thought to have swallowed a one-

million-solar-mass satellite body some ten million years ago,

setting off a burst of star formation in its centre that has yielded

Deep-Sky Contemplations
by Warren Finlay (warren.finlay@interbaun.com) and Doug Hube ( jdhube@telus.net), Edmonton Centre

Figure 1 – Position of NGC 288 and NGC 253 in the night sky.

Figure 2 – Finder chart for NGC 288 and NGC 253 shown with 0.5°, 2°,
and 4° Telrad circles.

mailto:jdhube@telus.net
mailto:warren.finlay@interbaun.com
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Figure 3 – 50’x50’ POSS image of the field that includes NGC 288.

Figure 4 – 50’x50’ POSS image of the field that includes NGC 253.

a new cluster of 1.5-million solar masses whose birth is in

counterpoint to the fading reign of NGC 288.

Next time you have a night of good transparency, have a

look at these two horizon-hugging beauties. Better hurry though

— you only have a billion years before NGC 288 exits the cosmic

stage.

Warren Finlay is the author of “Concise Catalog of Deep-sky Objects:

Astrophysical Information for 500 Galaxies, Clusters, and Nebulae”

(Springer, 2003) and is this year’s RASC Simon Newcomb Award

recipient. Doug Hube is a professional astronomer retired from the

University of Alberta.

Figure 5 – Image of NGC 288 from the Sloan Digital Sky Survey.
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Now you must know that a City Mouse once upon a time went

on a visit to his cousin in the country. He was rough and ready,

this cousin, but he loved his city friend and made him heartily

welcome. Beans and bacon, cheese and bread, were all he had

to offer, but he offered them freely. The City Mouse rather turned

up his long nose at this country fare, and said: “I cannot understand,

Cousin, how you can put up with such poor food as this, but of

course you cannot expect anything better in the country; come

you with me and I will show you how to live. When you have been

in the city a week you will wonder how you could ever have stood

a country life.” No sooner said than done: the two mice set off for

the city and arrived at the City Mouse’s residence late at night.

“You will want some refreshment after our long journey,” said

the polite City Mouse, and took his friend into the grand dining-

room. There they found the remains of a fine feast, and soon the

two mice were eating up jellies and cakes and all that was nice.

Suddenly they heard growling and barking. “What is that?” said

the Country Mouse. “It is only the dogs of the house,” answered

the other. “Only!” said the Country Mouse. “I do not like that

music at my dinner.” Just at that moment the door flew open, in

came two huge mastiffs, and the two mice had to scamper down

and run off. “Good-bye, Cousin,” said the Country Mouse, “What!

going so soon?” said the other. “Yes,” he replied; “Better beans

and bacon in peace than cakes and ale in fear.”

— Æsop’s Fables

O
nce upon a time there was a city mouse who was an

amateur astronomer. He lived almost all his life in one

city or another. When he was a young mouse, there was

not much light pollution, and he was able to spend many nights

on his back porch gazing at the stars. When he returned to

astronomy as an older mouse he found that the city lights had

become much brighter and that he was hard pressed to see all

but the brightest stars. So he tried to visit his country mouse

cousins as often as he could, but that was not often enough to

satisfy his craving to observe.

Our city mouse studied many books on observing, and got

much advice, some good and some bad. Some said “The perfect

telescope for urban observing is a small refractor,” but he found

that he could see even less with this than with his larger telescopes.

Thus he learned that, as in other locations, in the city, aperture

rules. In fact it takes a significantly larger telescope in the city

to equal the views of a quite small telescope in the country.

He learned to modify his observing targets in order to have

satisfying observing experiences in the city. He concentrated

on the Solar System, observing the Sun, Moon, and planets.

When there were no planets around, he consulted his Observer’s

Handbook and tracked down a number of bright asteroids, and

watched them move through the sky from night to night. He

once spent a wonderful night watching Pallas pass through the

outer edges of the star cluster Messier 47 (February 28/29, 2000).

He discovered that the beauties of double and multiple stars

were undimmed by light pollution, and observed all of the stars

on the Astronomical League’s Double Star Club list
(www.astroleague.org/al/obsclubs/dblstar/dblstar1.html).

One of his mouse friends named Richard encouraged him to

observe variable stars, and this proved to be the most rewarding

observing of all: no matter what the state of light pollution,

moonlight, or seeing, there were hundreds of variable stars

visible! He spent less time looking for deep-sky objects, as these

were hard to find in his city skies and, once found, rather

disappointing to look at, if they could be seen at all. He saved

his deep-sky observing for those rare times he visited his country

cousins, when the views were much more satisfying.

A little over a year ago, this city mouse decided to move

permanently to the country. At first he spent a great deal of

time observing those deep sky objects he had been deprived of

for so long. But, by and by, he found that one faint, fuzzy galaxy

looked much like every other faint, fuzzy galaxy. Then he heard

that Jupiter’s Great Red Spot had been joined by a smaller friend

of similar hue, Red Jr. Soon our newly minted country mouse

was back observing Jupiter with fresh enthusiasm. And as Jupiter

disappeared into the twilight, he found himself returning to

another of his city favourites, variable stars.

Just around the time the city mouse made his move, he

acquired a 150-mm Dobsonian with digital setting circles (DSCs).

With this, he discovered he could see variable stars as faint in

the country as the faintest stars he could ever see in the city

with his 280-mm reflector. He also discovered that he could

move from variable to variable much more quickly with the

help of the digital setting circles. He’s now purchased DSCs for

his larger scope. Some of his more conservative mouse friends

say he’s gone over to the Dark Side, but he doesn’t seem to mind.

One of the things that surprised the city mouse on moving

to the country is that he was much less bothered by wildlife. In

Through My Eyepiece

City Mouse and Country Mouse
by Geoff Gaherty, Toronto Centre (geoff@foxmead.ca)

mailto:geoff@foxmead.ca
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the city he’d shared his backyard with neighbourhood skunks

and raccoons. In fact he almost lost an eyepiece to a marauding

raccoon one night. The eyepiece had been deftly removed from

its case and carried half way across the yard before it was

retrieved! In the country, although our mouse hears rumours

of bears and moose in the area, his most dangerous foe has been

the lowly mosquito, which seems to exist in astonishing numbers.

But the transposed mouse’s greatest pleasure is, no matter

what he may be observing in his telescope, the opportunity to

sit back from the eyepiece now and then, and just take in the

beauty and richness of the dome of stars overhead. That’s like

having the cakes and ale without the fear!

Gizmos

I
n our rush to see stars light-years away we tend to ignore

the star next door — the Sun. True, it’s hard to look at. You

need special filters or even special telescopes, and the more

you want to see the more you need to spend. But for simple

sunspot viewing, this eyepiece projector is easy, safe, and

inexpensive. We use ours in a Meade ETX 90 but it will work in

almost any reflector. The components are from the plumbing

department and from your eyepiece box.

Plastic pipe comes in two main flavours. ABS, the black

stuff, is used for waste pipes, and PVC, the white stuff, is used

for water. We used some of each in this project because not all

the fittings are available in either type alone. You need a 3×11⁄2˝

ABS reducer, a 11⁄2˝ length of 11⁄2˝ ABS or PVC pipe (you can

buy this by the foot and you can use either), a 11⁄2˝×11⁄4˝ ABS

reducer, a 11⁄4˝×1˝ PVC reducing bushing and an eyepiece. Put

it all together like the picture. You don’t need to use glue because

the “interference fit” of these parts is snug enough to hold things

together without it. The Meade 20-mm eyepiece we used is a

friction fit in the 11⁄4˝ reducing bushing. If yours isn’t, wrap it

with tape or try a different fitting.

The screen is made of ordinary copy paper. Treat it with

vegetable oil applied with a paper towel. Wipe off all excess and

let it dry for a few days. Wrap the paper over the open end of

the big reducer and stretch an elastic band around it. Pull the

paper as tight as possible and trim with scissors. That’s all there

is to it.

In use, remember that the Sun is the engine that powers

our world. Sunlight can be dangerous. Focused into your retinas

by even the smallest telescope it has so much raw energy that

your eyesight can be destroyed almost instantly. Sunlight reflected

from an 8-inch, 10-inch, or 12-inch mirror is more useful for

boiling tea than for viewing. The image projected on the screen

is far too bright to look at and there may even be a heat build

up that could damage the eyepiece. The easy solution is just to

cover most of your mirror with a mask. Make it out of a file

folder or similar paper, cut a hole in it off-centre (2 inches or 3

inches in diameter is plenty), and tape it over the end of the

tube. Aim your scope by watching its shadow. When the tube

casts no shadow on any side the Sun will appear on the screen.

A 20-mm eyepiece is a good match for the 1250-mm focal

length of the ETX. It projects a solar image about 50 mm in

diameter on the screen. With a 1500-mm Dob it projects an

image that almost completely fills the 3˝ screen. A scope with

a longer focal length will need a different eyepiece. Experiment,

but don’t use your Naglers for this, and don’t use a refractor

because there may be damaging heat issues.

Focus until you see a nice crisp edge and sunspots will

appear as shadowy blobs. Check them out daily to watch their

progress across the face of the Sun and go to SOHO
(http://soho.nascom.nasa.gov) to compare with what

the big money sees.

Sun Screen
by Don Van Akker, Victoria Centre (don@knappett.com)

mailto:don@knappett.com
http://soho.nascom.nasa.gov
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The Sun is a fascinating study. When you see sunspots

follow them day by day and watch their progress. Get the kids

involved but teach them the precautions. Protect your eyes and

don’t forget the sunscreen.

Don Van Akker observes with his wife Elizabeth from Victoria and

Salt Spring Island. He can be contacted at don@knappett.com to

answer questions about any Gizmos project and would love to hear

about some of your ideas for future articles.

Erratum: An Amazing RR Lyrae Star - XZ Cygni

Due to overly-aggressive editing in the XZ Cygni article (Ramblings..., JRASC, June 2006, p. 130) the method of variation of this star as
stated in the second & third paragraphs is not an accurate representation of the pulsation method for RR Lyrae stars. The paragraph
should read

RR Lyrae stars are pulsating stars. The class of stars is named after the brightest example, RR Lyrae (of course). RR Lyrae stars are
low-mass stars of about 0.7 solar mass that are very old and evolved enough to have begun burning helium in their cores. Burning
helium causes the star to expand and leave the Main Sequence. As it expands the temperature drops, stopping the helium burning and
the star shrinks again. This pulsation is seen as a cyclical brightening and dimming of the star. This mechanism is basically similar to
classical Cepheid stars, but RR Lyrae stars have shorter periods, generally one-half to one day. Another difference is that RR Lyrae
star are Population I stars - or stars found in the halo of the Milky Way, whereas Population II Cepheids are found mostly confined to
the galaxy’s disk. Differences in these stars’ mass and composition cause them to be classified in separate pulsating categories.
RRLyrae stars were first found in abundance in globular star clusters, so they are often referred to as cluster variables. (See the amazing
animation at the Astronomy Picture of the Day Web site given in the Internet Resources section). However, it is now known that these
variable stars are distributed over the whole sky.

I would like to thank Walter Zukauskas for pointing out this error (and we apologize for the error - ed.)

mailto:don@knappett.com
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A
fter several articles dedicated to getting amateur

astronomers to expand their observing programs to

include visual estimating of variable stars, I figure I

should do the same with those who have chosen CCD cameras

as their major method of viewing the skies. CCD astrophotography

has taken off like the wind, replacing cooled film as the medium

of choice. With a good quality CCD camera and a colour-filter

wheel, imaging that formerly took days and weeks of exposing

at the scope and hours in the darkroom now takes much less

time and produces results much more quickly.

Soon after the invention of CCDs in 1969 at AT&T Bell

Labs, they were found to be ideal for astronomical imaging due

to their sensitivity over a very wide spectral range from ultraviolet

to infrared. Demand for better astronomical images and denser

arrays helped accelerate the devices’ development. About a

dozen years ago commercial CCD cameras became available to

amateurs. This put amateurs into the league of professionals

for imaging and data gathering. Amateurs have never looked

back!

CCDs are valuable detectors because their images, or more

correctly, the data collected by the CCD and used to create the

images, can be electronically and mathematically manipulated.

Each CCD pixel contains a specific number of charges that can

be stored, counted, mapped, and interpreted. Counting gives

quantitative measurement of intensity, and mapping allows

images to be created and interpreted. The data can be manipulated

by stretching and compressing using mathematical algorithms.

Images can also be stacked together, which reduces electronic

noise and allows fainter objects to be seen. This ease of manipulation

makes CCDs wonderfully versatile tools whose image quality

now rivals that of film. Exposure times that used to be hours

on film now take mere minutes with the CCD. Furthermore,

the images can be kept for the future as files stored on CDs or

DVDs, and can be recalled and reprocessed at any time.

There are several applications for CCD cameras: most

common are imaging, measuring, and data gathering, or in

Ramblings of a Variable-Star Addict

Introducing CCD Variable-Star
Photometry
by Richard Huziak, Saskatoon Centre (huziak@sedsystems.ca)

Figure 1 — A visual light curve of the rise of an RR Lyrae star XZ Cygni.
This is a pretty good light curve, and useful timings will come from it.
Individual points are somewhat scattered, though, and none of these
measurements can be made again to improve this exact light curve.
Compare this to a similar star shown in Figure 2.

Figure 2: The CCD light curve of the RR Lyrae star RR Geminorum. With
the precision of CCDs, a very nice continuous light curve can be generated.
Data points from over 300 images were used for this curve. The quality
difference from XZ Cygni (Figure 1) is obvious.

mailto:huziak@sedsystems.ca
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other words, astrophotography, astrometry, and photometry.

Most astronomical CCD cameras “see” in black-and-white,

producing monochromic images; if colour images are desired,

it is accomplished by taking exposures through red, green, and

blue (RGB) filters, then computer stacking these exposures to

produce the colour images. Full-colour cameras do this in one

step, but their use in photometry is more complicated; I will

discuss only monochrome CCDs in this article.

Photometry begins by imaging a target star with one

monochromatic filter, then using measurement software to

count the number of photon charges that have been captured

to make up the image of the star. A single CCD image may

contain hundreds or thousands of star images and every star

in the image can be measured. Carefully done, CCD cameras

allow you to image a field, and then measure the brightness of

the variable stars in the field to great precision. Combining

astrophotography with photometry can provide both interesting

pictures and a lot of scientific data. However, there is a catch.

CCD astrophotographers traditionally adopted RGB filters

from the film industry in order to reproduce accurate colour

renditions with electronic images. However, RGB filters are too

broadband for most scientific data collection, and professional

astronomers have adopted a different set of filters that are

narrowband and are tuned to parts of the spectrum that will

provide astrophysical clues to the goings-on of the objects they

are studying. The most common science filters are called U, B,

V, R, and I, which translate roughly to near-ultraviolet, blue,

green-yellow, red, and infrared. These five filters sample most

of the visible or near-visible spectrum, and most measurements

intended to be done for scientific purposes need to be done

through one of these filters so that data can be interpreted and

compared within a standard system. If you want to make

measurements in the same way that professionals do, it is

important to use the same baseline. Unfortunately, RGB filters

do not fit this bill.

However, the science of simple repetitive measurement as

is done with variable-star photometry can be done with any

one of these narrowband filters, with the default standard being

the V-band filter. Conveniently, the V-filter is centred very near

the yellow part of the spectrum where our eyes are most sensitive,

so images taken through a V-filter tend to represent the sky

much the same as our eyes do. 

So as it turns out, CCD astrophotographers are only one

step away from being able to do useful scientific photometry

of variable stars. They already have most of the required

paraphernalia: a tracking telescope, a computer, a filter wheel,

a CCD camera, and CCD control and data-gathering software.

By writing this article it is highly unlikely that I will instantly

convert hard and tested astrophotographers to enthusiastic

photometrists, but I do have a compromise to suggest. Most

filter wheels have five or six spaces for filters and most filter

wheels used for astrophotography have R, G, B, and maybe IR-

blocking and clear filters in them. This provides an opportunity

for the empty or clear position be populated with a V-filter, and

that allows for the capture of images suitable for photometry

when the need arises. 

Adding a single V-filter to your filter wheel allows you to

expand your observing horizons and now and then contribute

to science by making measurements of targets of opportunity,

such as newly discovered novae, supernovae, interesting variable

stars, or even asteroids and exo-planet transits! When doing

colour imaging of these objects, or any objects in the sky, swing

the V-filter into place and record an additional image that can

later be measured. One handy fact is that CCD photometry is

generally done slightly out-of-focus, so on nights where image

size is not small enough for astrophotography, very good

photometry can be done, providing an opportunity to use

otherwise ideal telescopes.

Should you decide to do a wholesale changeover to UBVRI

filters, you can continue to do colour astrophotography. As a

matter of fact, virtually all the amazing Hubble images you may

have seen in astronomy magazines are made through these

filters (plus some extras). Everyone oohs and aahs at these

images, but few of us think about the filters that were used. The

difference is that every Hubble image contains electronic

information that can be interpreted or measured because a

standard set of filters was used, and information can be read

off each image layer. By switching to BVR filters and substituting

these for RGB filters, a creative astrophotographer can accomplish

both colour imaging and photometry in each of these three

bands. The downside is that exposure times must increase

because the narrowband filters allow less light to pass through

them.

So what are the advantages of CCD photometry over visual

estimates? CCD photometry involves basically the same steps:

measurements are made of a variable target using a set of

standard comparison stars. However, a visual observer makes

a real-time estimate of the brightness by interpolation — a best

Figure 3: The light curve of a new δ Scuti variable in Cepheus discovered
by the author in July 2006. Note that the range is only 0.06 magnitudes,
but this is easy with modern CCD equipment. The decreasing amplitude
for the variation indicates that the star is vibrating in more than one
period at a time. The light curve is six hours long and includes about
350 measurements.
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guess between two or more comparison star values. The estimate

made by a reasonably experienced observer generally gives a

value good to 0.1 or 0.2 magnitudes, with an error generally

estimated to be ± 0.1 mag. But the estimate is a f leeting

measurement, and the observer can’t go back a few days later

and recheck that exact observation. Visual observers are also

doomed to follow variable stars with amplitudes of 0.5 magnitude

or greater or the light curves become lost in their errors.

A CCD measurement is done from the image data. With

experience and decent sky conditions, an observer can electronically

measure the magnitude of a star to ±0.01 magnitude with an

error generally <0.01 magnitudes — ten times finer than the

visual observer. Furthermore, the measurement can be repeated

or checked later if the image files are retained. With some

practice, amateur photometrists are reliably following the light

curves of stars with amplitudes as small as 0.01 magnitude.

This opens up the whole new world of microvariability to amateur

research, and allows amateurs to participate in the search for,

and follow-up of exo-planet transits. Just a few months ago, a

campaign involving several amateurs resulted in the detection

of the first planet transit around the star XO-1 in Corona Borealis.

The passage of this hot Jupiter-type planet (XO-1b) across the

star caused a drop of a mere 0.025 magnitude. Even so, it was

easily detected. 

With the obvious accuracy of CCD photometry, what

happens to the future of visual variable-star observers? Well,

nothing! Visual observers fill a very important niche. There are

a lot of visual observers, so they can follow hundreds of stars

nightly, estimating longer-period Mira or semi-regular stars at

which photometrists rarely look, or cataclysmic variables and

other unusual stars looking for signs of activity that would

trigger researchers into action. So if you are satisfied with doing

visual observing, we all still cherish your hard-earned observations!

Visual observers in the AAVSO have been following some stars

for almost 100 years, providing valuable long-term light curves.

This work needs to continue.

There are some pitfalls to CCD imaging of the sky. One

problem is that unfiltered CCD cameras are very infrared-

sensitive. Some astrophotographers use IR-blocking filters to

reduce imaging issues but every month I receive an email from

an astrophotographer imaging with no filter stating that they

have discovered a new star where one should not be. My first

course of action is to search the coordinates for a Mira star or

other red giant at that position in the sky, no matter how faint.

These stars emit most of their energy in the infrared part of the

spectrum so it is not unusual for these stars to look six or seven

magnitudes brighter than on a visible-light image. Unfiltered

CCD cameras are responsible for many false discoveries. Using

the narrowband science filters completely cures this. On the

other hand, those wishing a great challenge can invest in an

I-band filter and do photometry in the infrared. The infrared

sky is an unfamiliar area and many new discoveries await

I-band amateurs.

One other drawback is that astronomical CCD cameras

are still quite expensive and out of the reach of some amateurs.

A few years ago, Meade introduced the monochrome Deep Sky

Imager. Arne Henden, Director of the AAVSO, reviewed this

camera in Sky & Telescope magazine and found it worthy as a

beginning CCD camera for photometry; all for only a few hundred

dollars. Digital cameras are now very popular and are producing

amazing images of the sky. Although CCD-based, useful photometry

cannot yet be done with these, it may just be a matter of time.

So much awaits the dedicated amateur who invests in a

CCD camera and a V-filter!

Resources

AAVSO Photometry Handbook 
www.aavso.org/observing/programs/ccd/manual

Discovery of a New Exo-planet

http://hubblesite.org/newscenter/newsdesk/

archive/releases/2006/22/full

Dr. Arne Henden Review of Meade DSI

And Science, Too!, Sky & Telescope, October, 2005

History of CCDs 

www.ctio.noao.edu/CCD-world/Janesick.html

Richard Huziak converted from a visual observer to a CCD observer

two years ago, though he still gets to his Dob occasionally. He enjoys

the precision of the measurements and the possibility for amateurs

to do research and publish scientific papers. To keep him busy for

the next few decades he has adopted a program to sort out whether

or not 1400 suspected variable stars in the AAVSO catalogue are or

are not variable. The sense of imminent discovery keeps him going

— he currently is making brand new variable-star discoveries about

every third night of imaging, proof of the power of CCDs!

http://www.aavso.org/observing/programs/ccd/manual
http://hubblesite.org/newscenter/newsdesk
http://www.ctio.noao.edu/CCD-world/Janesick.html
http://hubblesite.org/newscenter/newsdesk/archive/releases/2006/22/full/
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N
ot long before conducting the interview for this issue’s

column, an earthquake struck fairly close to my home.

Well, struck may be too dramatic a term since the tremor

was just barely detectable. Yet it was, I thought, well timed,

since the subject of this column, Dr. David Guenther of St. Mary’s

University, Halifax has a keen interest in quakes...albeit none

that occur on this, or any other, planet.

While doing initial research on Dr. Guenther’s Web site, it

wasn’t anything astronomical that first caught my attention.

Rather, it was the venue for some of his physics classes — The

Gambia. For the past decade, St. Mary’s has assisted in the

development of higher education in this West African nation.

Working with the government of The Gambia and other sponsors,

faculty from Canadian universities and Gambian colleges taught

university courses in a country that, at the time, had no university

of its own. The core of the faculty came from St. Mary’s. After

the first 5 years, some 200 Bachelor’s degrees had been conferred.

Dr. Guenther’s course was the first university-level physics taught

there. By volunteering to participate he not only seized an

opportunity to visit Africa but to do something both challenging

and eminently worthwhile. It wasn’t easy.

A nominal 13-week course had to be taught in 6 weeks.

There was no equipment, no resources, and no real data with

which to work. The climate was hot and humid and required a

long acclimation period. Fortunately, the students were “very

eager and talented.” Some ultimately went on to study in Britain,

France, or St. Mary’s itself. However, for many, it was not possible

to go abroad and most waited for the eventual opening of

Gambia’s first university (which, according to its Web site, offers

a course in cosmology). In any case, the government asks that

the students stay (or return) to apply their expertise at home.

Another attention-getter on Dr. Guenther’s Web site was

a link entitled “The Meaning of Life.” This takes one to a painting,

by Eugène Delacroix, of an orphan girl in a cemetery. I did not

get a clear-cut answer as to why she was here. Instead, I was

invited by Dr. Guenther to ask questions.

“Why is she there?”

“What do you think she is thinking?”

“What is important in life?”

It was up to me to decide. Dr. Guenther enjoys mixing

disparate elements together thereby fostering inquisitiveness.

(It turns out that this Web page gets a large number of hits and

Dr. Guenther is rather distressed that so many people find it

necessary to seek the meaning of life online.)

As for Dr. Guenther, he is seeking the meaning of quakes

— star quakes, that is. Just as geologists can listen to different

earthquake-generated sound waves and deduce the inner

structure of our planet at different depths, helioseismologists

can do the same with the Sun and other stars.

It was in the early 1960s that astronomers detected solar

absorption lines moving back and forth, a Doppler effect due

to gas rising and falling through a distance of several metres in

the solar atmosphere every few minutes. This turned out to be

the surface manifestation of sound waves trapped more deeply

in the Sun. These standing waves, like the wind-generated waves

that cause a telephone wire to hum, churn the Sun’s surface into

a boiling porridge of millions of separate oscillations that

combine to make different surface patterns. Is the Sun humming,

then? Might we be able to listen to its symphony? Alas, no. The

Dr. David Guenther
by Phil Mozel, Toronto and Mississauga Centres (phil.mozel@sympatico.ca)

A Moment With…

Dr. David Guenther 

mailto:mozel@sympatico.ca
mailto: phil.mozel@sympatico.ca


JRASCOctober / octobre 2006 225

range of frequencies tops out around twenty cycles per second,

below the human threshold of hearing. And the cause? Turbulent

motion in the outermost layers of the Sun’s convective envelope.

With the changing distances of the rising and falling gas

being miniscule, special equipment is needed to detect the effect

when studying distant stars. This is where the Canadian

Microvariability and Oscillations of STars (MOST) satellite comes

in. Its 15-cm telescope is designed to stare at a target star for

weeks on end and is capable of noting ridiculously small changes

in brightness (comparable to detecting the “brightness variations

caused by moving your eye just one-half millimetre closer to,

or farther away from, a streetlight located one kilometre away”).

No other device is capable of doing this. Making detections like

these provides the data upon which theories of how stars operate

will be built. The numbers provided by MOST will be crunched

at St. Mary’s Institute for Computational Astrophysics using

software developed by Dr. Guenther, who is a member of the

MOST science team. This allows astronomers, for the first time,

to essentially get a detailed look inside far-distant suns.

The numbers indicate that MOST is seeing oscillations in

other stars although they may be caused by mechanisms other

than those operating in the Sun. And, during our conversation,

Dr. Guenther expressed his excitement at the prospects of a

meeting a few days later where MOST data for Alpha Centauri

would be presented. These results will have an accuracy of one

part in ten thousand. Solar results are accurate to one part in

one hundred thousand! Not bad, considering that some astronomical

results, particularly in years gone by, had double-digit percentage

errors!

Asked if working with MOST has been exciting, the answer

comes back strongly in the affirmative! Aside from the issue of

national pride, there is also the matter of being one of the first

explorers to face these new problems and to work on them using

a new tool. Team members have turned up much that is unexpected,

which “is what a scientist wants.” After all, scientists “would

rather have questions than answers.”

As for getting into this business in the first place, it seemed

like a stupid thing to do, at least according to some people with

whom Dr. Guenther conferred. He had always wanted to be a

scientist but was advised to become a physicist because, after

all, how can you make a living as an astronomer? Ultimately,

he did what he had always wanted, and turned to the stars. His

influences? The term Star Trek came up at this point, with Dr.

Guenther suggesting that many people became scientists because

of its influence, which may have been even stronger than that

of the Apollo missions. There were other influences not elaborated

on. I was once again asked to explore on my own by following

the Acknowledgements link on his Web site, as the reader is also

invited to do.

And that’s the way it went: the interviewer being challenged

to ask more questions and explore the unexpected. This is also

what Dr. Guenther hopes of all amateur astronomers. For example,

he suggests that amateurs will be first to see certain types of

stellar variability. He is emphatic that we do observe and submit

our results. Then there is the question of Dr. Guenther’s story

of the stars and sheep...but that is an answer you will have to

find for yourself.

(Dr. Guenther may be found at apwww.stmarys.ca/~guenther/

guenther.html).

Philip Mozel is a past Librarian of the Society and was the

Producer/Educator at the former McLaughlin Planetarium. He is

currently an Educator at the Ontario Science Centre and a member

of the new Mississauga Centre of the RASC.

O
ur December issue will celebrate the 100th volume of

the Journal and we’d like to paste your verbal memories

into that issue. Do you have a special moment in

astronomy that occupies a small corner of your long-term

memory? It might be a person who helped you along, an open

cluster that struck just the right visual note one night, an

event — meteor shower, occultation, or aurora perhaps —

that brings a warm feeling in a quiet moment. We’d like you

to share it with us and with the generations of RASCals to

come.

It can be poetic, photographic, sketched, or literary.

A small paragraph (no more than 3 sentences and 50

words) will do just fine. A credit-card sized photo (300

dpi please), a sonnet or haiku, a small drawing — even

a clean limerick (no one said it would be easy). We’ ll

pick the best, or the most nostalgic, or the one with the

correct punctuation of a compound adjective. Those

selected will be published in Volume 100 in December.

Contributions should be sent to editor@rasc.ca by mid-

October.

Memories Wanted

mailto:editor@rasc.ca
apwww.stmarys.ca/~guenther/guenther.html
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“There was so much to say, but she’s already gone, so

Thank you Carmen, don’t be afraid; this is not the end,

So rest your head, I hope someday we will meet again.

Goodbye, Carmen”

— From the song Good-bye Carmen,

by Wilson Phillips, © 1992, Wilson Phillips

C
armen and I had a date last July 26. She promised to rise

up above the eastern horizon and then, at 02:54 UT, do

a neat little magic act, making her colleague, a real HIP

star performer, 100244 disappear. Excited, I went to our agreed

rendezvous spot at a place called Nirvana by local astronomers

— actually an abandoned airstrip ninety minutes north of

Kingston, Ontario. Wanting to preserve the magic moment for

posterity, I set up my telescope, a low-light “surveillance” video

camera and a TV/recorder combo unit. Carmen and HIP 100244

(“244” to her fans) appeared on schedule, but failed to perform

their promised trick. 244 just glowed more or less steadily in a

clear, but turbulent sky while I watched her on the monitor and

did my best to feed Nirvana’s mosquito population. (Question:

Why do they call it Nirvana when it has all these hellish insects

in abundance?)

Actually, I was not Carmen’s only admirer on this occasion.

Unfortunately, though, the infamous Cloud Curtain failed to

rise sufficiently, so most were prevented from viewing the stage.

They were “clouded out.” The rest of us watched, but nothing

special happened. Carmen (aka Asteroid 558) and her stellar

companion wandered onstage together and just hung around.

After awhile we all got bored, packed up and left.

The audience on the north side of the stage might have

seen the effect, but unfortunately, everyone on that side was

foiled by that balky Cloud Curtain. Even Geoff Gaherty, near

Coldwater, Ont., who staked out front row centre, was done in

by the Curtain. But a few of us on the south side of the house,

including Eric Briggs near Barrie, Ont.; Leo Enright in Sharbot

Lake, Ont.; Phil Mozel in Mississauga, Ont.; Kim Hay and Kevin

Kell in Yarker, Ont.; and me in Nirvana, managed to dodge the

Curtain. But none of us saw anything unusual. Well, almost

none of us. Eric Briggs recorded a 23-second disappearance of

HIP 100244. Expert critics contend that he must be in error,

since Carmen is not equipped to hold the effect for more than

about 4.6 seconds. We have no indication that Carmen was on

steroids or otherwise “pumped up,” so we think that a tattered

end of the Cloud Curtain must have blown up and over at just

the wrong time.

Although Carmen disappointed us, we didn’t give up on

her. She promised to try again with a different partner — a much

less prominent starlet — on August 6. That gig would be even

farther from home, so, given the act’s record, I decided it was

just too risky to invest in the extra gas and time. Instead, I chose

to watch from my Gneiss Hill Observatory in eastern Ontario

in case the Carmen entourage got a little off track — an all-too-

common occurrence for these asteroidal magicians.

I took my seat in good time, but, again, Carmen let me

down. This time I even got a good look at Carmen all by herself

before she approached her new partner, TYC 6315-01445-1

(“Little Tyke”). But still the star failed to disappear. Most of the

audience from the previous show did not return for this reprise.

But those who did, including Frank Dempsey and Geoff Gaherty,

were again foiled by that pesky Cloud Curtain.

Note to asteroid (558) Carmen: You eluded us twice in a

dozen nights, my Pretty! But one of these nights we’ll catch your

act. For now all we can do is move on to other performers when

they come to town. “I hope someday we will meet again.” Make

that some night.

Here’s a list of upcoming potential asteroidal occultations

over populated Canada. For more information on these and other

events, including target star coordinates, finder charts, etc., please

visit Steve Preston’s Web site: www.asteroidoccultation.com.

Interactive Google maps for many of these occultations will be

posted by Derek Breit at http://www.poyntsource.com/New/

index.htm at least one week prior to the events. I’m sure you’ll

find at least one occultation coming to a sky near you. Please

advise me of your plans.

Notes to the table:

Particularly favoured occulations are marked by an asterisk (*)

Oct 18 Quintilla: The asteroid will occult both components of

the double star, HIP4716. Pick one and let me know your choice,

please.

Oct 30 SAF: A binocular occultation! The star is 70 Aquilae (mag

4.9).

Nov 20 Tyson: The star is SAO 77744, 6.6° due east from ß Aurigae.

The shadow path is only 11 km wide and the confidence of the

predictions (at the time of writing) is extremely low. But other

circumstances are good (star magnitude, altitude, absence of

moonlight, etc.). Observers within 100 km of the path are

encouraged to watch anyway. We know very little about “5-digit

asteroids.” All observations, even without good timing, would

be useful.

Carpe Umbram
by Guy Nason, Toronto Centre (asteroids@toronto.rasc.ca)

mailto:asteroids@toronto.rasc.ca
http://www.asteroidoccultation.com
http://www.poyntsource.com/New/index.htm
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Nov 26 Clarissa: Observers in every province except Newfoundland

and Labrador have a good chance of seeing this event. It could

be a truly national effort.

Dec 12 Kalatajean: Another small asteroid with a very uncertain

path. (See Nov 20 Tyson above.) The star is SAO 40512, 5°

southwest from ß Aurigae.

DATE TIME ASTEROID STAR CHANGE IN MAX DUR PATH
2006 (UT) NUMBER NAME MAG MAGNITUDE (s)

Oct 01 10:10 1724 Vladimir 10 6 3.5 nBC-sSK
Oct 03 0:51 25 Phocaea 8.8 1.6 6.3 eON
Oct 04 7:45 74 Galatea 10.1 2.2 48.4 eQC-wNL
Oct 06 12:38 144 Vibilia 11.6 1.2 8.9 sBC
Oct 07 2:21 341 California 7.1 6.1 1.8 nON
Oct 07 2:29 1605 Milankovitch 10.1 4.4 2.8 eNL
Oct 07 5:47 119 Althaea 11.3 1.1 9.6 cON
Oct 09 1:09 200 Dynamene 11.3 1.3 37.9 swON
Oct 11 9:33 46 Hestia 11.7 0.6 21.9 nON-seMB
Oct 15 4:40 208 Lacrimosa 11.9 2.5 4.5 seSK-swMB
Oct 18 4:52 1116 Catriona 9.8 5 5.2 SK only
Oct 18 6:20 755 Quintilla 7.6 7.4 2.5 NL-cQC-cON*
Oct 18 6:20 755 Quintilla 8.8 6.2 2.5 NL-cQC-cON
Oct 22 9:56 88 Thisbe 12.6 1 10.3 sBC-cON
Oct 27 1:52 1187 Afra 10.1 3.6 4.6 NL-QC-ON
Oct 28 8:37 275 Sapientia 12.4 1.4 12 swNS
Oct 29 12:06 101 Helena 12.3 1.3 6.1 sBC-wcSK
Oct 30 3:28 4162 SAF 4.9 12.1 1.5 nBC-nON*
Nov 03 6:08 132 Aethra 11.9 1.8 2.8 cQC-cON
Nov 03 7:35 24 Themis 11 1.2 9.5 nMB-sBC
Nov 06 10:32 258 Tyche 11.7 1 8.2 AB-seBC
Nov 07 3:35 1980 Tezcatlipoca 10.4 3.3 1 NL
Nov 09 5:08 695 Bella 11.7 1 4.7 nwON
Nov 10 1:48 1040 Klumpkea 9.5 4.6 3.9 NL
Nov 12 2:28 3667 Anne-Marie 6.3 10 3.6 AB
Nov 12 5:12 637 Chrysothemis 11.8 3.8 3.1 nAB-cBC
Nov 16 7:55 414 Liriope 11.6 3.1 8.4 swON
Nov 17 6:41 1031 Arctica 11.5 2.7 5.5 swSK-MB
Nov 20 3:36 13123 Tyson 6.4 9.7 0.8 swNS-sON*
Nov 22 3:44 1988 Delores 11.3 5 2.8 nwON-seMB
Nov 23 6:49 1283 Komsomolia 10.9 3 2.8 NL-ON
Nov 24 9:50 18 Melpomene 11.2 0.4 27.5 seON-nBC
Nov 25 11:47 1980 Tezcatlipoca 8.6 4.5 1 nSK-cBC
Nov 26 3:51 422 Berolina 10.7 2.6 4.1 swNS
Nov 26 9:24 302 Clarissa 11.9 1.4 4.4 NS-BC*
Nov 27 7:14 2152 Hannibal 12.3 1.8 4.6 nMB-sAB
Nov 30 8:53 2806 Graz 9.8 6.4 2.3 sQC-sBC
Dec 01 9:37 242 Kriemhild 11.6 2.3 3.8 BC
Dec 01 12:25 407 Arachne 11.7 1.2 9.4 sSK-nBC
Dec 02 1:50 407 Arachne 9.7 2.8 9.3 cQC-cON
Dec 02 8:36 242 Kriemhild 11.7 2.2 3.9 swSK-cBC
Dec 02 9:42 1988 Delores 11.3 4.7 2.3 NS-nBC
Dec 05 6:10 3615 Safronov 7.4 9.2 1.7 NL-swSK
Dec 09 2:53 371 Bohemia 11.7 2.4 3 sBC-nQC
Dec 11 2:32 13832 1999 XR13 11.5 4.3 3.1 NL-ON
Dec 11 12:01 164 Eva 9.3 5.6 6 cMB-nwON
Dec 12 6:24 5976 Kalatajean 6.4 9.9 1 sON*
Dec 12 8:22 242 Kriemhild 11.1 2.6 6 eQC-NS
Dec 13 1:23 2961 Katsurahama 11.8 3.1 4.1 nNL-nON
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Pen & Pixel

Figure 1 — NGC 4565 in Coma Berenices by Albert Saikaley. This image was taken with a Celestron 11
at f/7 using an SBIG ST10-XME camera and an AO-7 guider. The exposures, in LRGB, were 60, 15, 15, and
20 minutes in duration. One of the best edge-on galaxies, NGC 4565 is a gem both visually and photographically.
At magnitude 9.7, its stellar core and dark dust lane can be seen easily through even modest telescopes.

Figure 2 —This image of M74 was provided by Stef
Cancelli, but was acquired using a telescope located
at Kitt Peak. According to Stef ”A bunch of us from the
RASC contributed to renting some time on the Kitt Peak
20-inch RC so we could share the data.“ The image
was acquired between October 5 and 7, 2005 by Paul
Mortfield and Dietmar Kupke using the 20-inch Ritchey-
Chrétien telescope at f/8.3. The exposure consists of
13 luminance images at 10 minutes each (binned 1×1),
and four 10-minute images (binned 2×2) in each of the
R, G, and B filters.
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I know that I am mortal by nature, and ephemeral, but when I

trace at my pleasure the windings to and fro of the heavenly

bodies I no longer touch earth with my feet: I stand in the presence

of Zeus himself and take my fill of ambrosia, food of the gods.

— Claudius Ptolemy

P
tolemy got a bad rap as far as I’m concerned. Certainly

he was anchored to a faulty premise — the geocentric

Universe — but his system of epicycles and deferents was

an ingenious attempt to solve a complex problem. The basic

idea of circles within circles was the right sort of geometry that

simply required Earth to be set free to trace its own loop around

the true centre of the Solar System.

Surely Ptolemy’s pleasure was peppered with puzzle when

it came to Mercury. Bound by the Sun’s tight gravitational leash,

the elusive innermost planet winds to and fro rapidly and

erratically. Its bi-monthly apparitions to either side of the Sun

last a few weeks at best, and are next to unobservable at worst.

How best to get a fix on the nature of the Winged Messenger’s

windings?

The keys to the puzzle were discovered 1500 years after

Ptolemy’s time by Johannes Kepler, who combined the theory

of Copernicus and the observations of Tycho with his own

elliptical insights and considerable mathematical skills to

develop his famous Three Laws of Planetary Motion (Sobel

2005). A man after my own heart, Kepler frequently strayed into

such interesting diversions as the perfect solids, the golden

ratio, and “the Music of the Spheres” in his quest to make cosmic

sense of it all (Gingras 2003).

Among Kepler’s many accomplishments were the successful

predictions of the transits of Mercury and Venus in  1631, in

November and December respectively. At such moments the

brilliant Sun, normally an implacable adversary that regularly

thwarts our view of Mercury, becomes an invaluable aid. The

prepared observer can briefly capture the Winged Messenger

in stark silhouette and measure, in the manner of a bird-bander,

its exact position and size.

As with all things planetary, such encounters are periodic.

Because they can only occur under exacting circumstances,

transits are particularly precise measuring sticks that will yield

true periodicities of the planet in question with respect to Earth.

Such periodicities can nowadays be calculated by other

means. Meeus (1997) discusses one such method using modern

values:

“The sidereal revolution periods of Earth and Mercury are

365.256363 and 87.969256 days, respectively. If we divide

the first value by the second, we obtain 4.152091. If we

Orbital Oddities

Transit Tandems and Tetrads
by Bruce McCurdy, Edmonton Centre (bmccurdy@telusplanet.net)

Figure 1 — The paths of the five transits 1986-2006 are shown.
As might be expected from such a proliferation of events, none of them
is particularly central. This is analogous to similar clusters of solar and
lunar eclipses such as duos, double duos, and tetrads, all of which involve
relatively grazing events. Note particularly the exceptional six-year pair
of 1993-99, two marginal events just barely falling within the opposite
extremes of the ten-day November transit window. Note also the
sequential calendar dates from bottom to top of the diagram; a central
transit would occur around November 10. The May transit at the descending
node is clearly the black sheep of this family. (Diagram courtesy Russ
Sampson, RASC Edmonton Centre and JRASC Contributing Editor.)

mailto:bmccurdy@telusplanet.net
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now search for successive fractions with integer numerator

and denominator, and which converge ever more closely

to the given value 4.152091, we obtain:

4/1   25/6   29/7   54/13   137/33   191/46   901/217

“In the denominators of these fractions we find the periods

[for Mercury]. For instance, the fraction 54/13 means that

13 sidereal periods of the Earth correspond to approximately

54 revolutions of Mercury.”

Meeus goes on to state that the first fraction corresponds to

1 year, but it is too inaccurate to be very useful. Experienced

observers will know that each year apparitions of Mercury occur

some 21⁄2 weeks earlier than the previous year. However, the

subsequent periods are increasingly accurate, and all can be found

in transits of Mercury (see Table 1). And if one looks hard enough,

even the one-year “period” can be found to play a role.

Using the best periods, Meeus (1989, 2002) developed a

panorama for each node with rows of 46 years and columns of

217, covering all transits of Mercury in an unbroken latticework

of dates. This spreadsheet is efficient in that every transit is

represented and every cell is full, but the intervals between transits

are not apparent, and the sequence of events can only be followed

by jumping around in a barely discernable pattern: for example,

the transit of 2006 appears 3 columns to the right and 14 rows

above its predecessor in 1999.

I have developed a different method I call a “window panorama”

(see Table 2). The columns are separated by six to seven years, the

time it takes Mercury to complete one extra revolution over and

above the base 4:1 ratio and effectively “lap” Earth. Each such

occurrence represents a window of opportunity. Sometimes the

window is open, sometimes it’s closed. But the gaps in the data

still contain information, as they accurately display the interval

between transits. Better yet, the transits are laid out in chronological

order.

The rows are at the excellent intermediate period of 46 years,

containing exactly seven windows, which at the ascending node

typically result in four, exceptionally five November transits. The

“full” windows form lengthy series of some 19 events at the 46-

year interval, with Mercury’s path across the Sun gradually shifting

northward from one event to the next, followed by a lengthy

hibernation at that window. For example, the grazing transit of

1999 was the last one of a series that began in 1171. In 2045 Mercury

will achieve inferior conjunction a few hours too late for a transit.

One year later it will be a number of days too early. But many

centuries after that, a new series starts in that window, offset by

one year to the sequence of the old series. Note that Series B will

resume in 2644, after a hibernation of 645 [(14*46) + 1] years. Thus

does the “imperfect” period of one year manifest itself, by allowing

the intervals between columns to vary between seven and six years.

The still better period of 217 years can be seen in the gradual

diagonal shift, typically two columns to the left every fifth row.

Note the start dates of the series: 1776-1993-2210-2427....

Space does not permit a similar panorama at the descending

node, which would be much sparser, with typically two transits

per seven windows of opportunity. To my astonishment I discovered

that in the present era, all May transits are invariably followed by

a November transit 31⁄2 years later, an inseparable pair I call a

“transit tandem.” Therefore the second panorama can effectively

be superimposed on the first! In Table 2 the second event of these

transit tandems is shown in bold (blue in the on-line JRASC),

and represents a pair of transits. The pattern of May transits can

be seen by simply considering those boldfaced entries, and dates

can be derived by subtracting three years.

The stability of this May-November romance can also be

readily seen. The columns show that the 10-event May series

currently occur just about dead centre in the 19-event November

series. In other words, every May transit is followed 31⁄2 years later

by a fairly central one in November, never a marginal event. I am

certain that one could search many millennia into the past or

future before finding a single example of a May transit without a

counterpart ~1282 days later. At present it’s an infallible predictor.  

On the other hand, since the “halves” of Mercury’s orbit are

asymmetric, May transits are immediately preceded by November

transits only rarely, with the invariable result a seven-year transit

trio such as has happened in 1999-2003-2006. (McCurdy 2006) 

The 2006 transit is the finale to quite an interesting sequence.

Not only is it the last member of a transit twin, tandem, and trio,

it is the final instalment of a rare transit tetrad. This is a group of

4 November transits in just 20 years, the sequence 1986-1993-

1999-2006. The rarity here is the 6-year interval 1993-99, which is

only possible with a pair of nearly grazing events at opposite poles

(see Figure 1). The next such tetrad will occur in the 29th Century.

Counting the May 2003 event, there have been five transits

in the past two decades. It follows that there will be a lull after the

2006 event. But circumstances favour us. After 91⁄2 years there will

be another May event in 2016, which is inevitably followed by a

November counterpart in 2019. Fortunately, North America is

again favoured for both, meaning it will have been possible for an

observer in a universally central location (say, Toronto) to have

observed 5 consecutive transits in just 20 years, plus 2 of Venus!

Only then will the expected lull kick in, with no more Mercury

transits to be seen from this continent until 2049. For now, however,

the transit gods are with us, so let’s follow Ptolemy’s lead and take

our fill.

Dedication

This column is dedicated to Dr. Doug Hube, Honorary President

of Edmonton Centre, astronomer, academic, marathoner, bird-

bander, and a pillar of every community fortunate enough to

have him.

Bruce McCurdy has long been fascinated with the natural rhythms

of the solar system. He does some of his deepest thinking on the subject

while attending concerts of the Edmonton Raga Mala Music Society,

of which he is a patron member of long standing.
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Table 1

The number of revolutions of Mercury in the first column results in roughly
an integer number of Earth years, plus or minus a few days. The R.
column is the remainder when dividing the first column by the second,
and represents the number of times Mercury “laps” Earth near the node
during the period in question. The periods of six and seven years are
not possible for May transits, as Mercury is displaced by more than the
solar diameter of >1900”; however both are possible in the November
window. The displacement during longer periods is roughly half as much
in November as May, so the number of repetitions in a series is about
double.

The period of 217 years and 3 days is especially accurate, generating
very long series at both nodes. The apparent “error” of 3 days is almost
commensurate with the precession of Mercury’s nodes, which is about
1.3 days per century. It is interesting that the 217-year period does not
follow the normal rule of displacements of opposite signs at opposite
nodes, in a similar manner as the 243-year period of transits of Venus
(McCurdy 2004). Both periods are so good that the small remaining
variations are due to oscillating secondary factors.

Table 2 

The Music of the Spheres, from the time of Kepler to a thousand years
hence. In this device I call a “window panorama,” the rhythm of transit
cycles can be seen. The columns separated by six or seven years represent
each window of opportunity for a transit. To this aficionado of Indian
classical music, the pattern resembles a seven beat tal (rhythm cycle)
subdivided into three groups, each ending in an “empty” beat. In fact,
such a rhythm is known as Rupak tal, seven beats divided 3-2-2 (Russell
1997).

As described in the text, the bolded events represent a transit
tandem where two transits occur in the window, descending (May) node
first, then ascending. The implied May transits can be considered to fall
a “half beat” ahead of their November counterparts. May transits never
occur in an empty beat.    

The letters labeling the columns were defined by Meeus (1989),
derived from the sequence of 46-year series (starting in 1600, Series A
ends first, then Series B...). That the columns are labeled A through G
evokes another musical analogy, that of pitch. The lowercase letters are
defined by the writer in simple chronological sequence of the transit
windows; each row could be played as a simple note progression or
chord, which would allow one to “hear” the gradually changing sequence
of the 46-year pattern. Kepler would have loved it!

Table 1.
Periodicities of Mercury

May # in Nov. # in 

Revs Years Days R. displ.  series  displ. series

4 1 -17 0 > S.D. - > S.D. -

25 6 +10 1 > S.D. - +1890˝ 2

29 7 -7 1 > S.D. - -1390˝ 2

54 13 +3 2 -1030˝ 2 +500˝ 4

137 33 -2 5 +830˝ 2 -390˝ 4

191 46 +1 7 -200˝ 10 +100˝ 19

901 217 +3 33 <+25˝ ?? <+20˝ ??

Table 2:
Transits of Mercury 1601-3000

Bold/blue - transit tandems: follow May transit by 31⁄2 years

Underline - transit duos (twins) at interval 2550 days

Italic plus underline - double duos (transit tetrads) 4 in 20 years

D G C F B E A

a b c d e f g

1605 1618 1631 1644

1651 1664 1677 1690

1697 1710 1723 1736

1743 1756 1769 1776 1782

1789 1802 1815 1822

1835 1848 1861 1868

1881 1894 1907 1914

1927 1940 1953 1960

1973 1986 1993 1999 2006

2019 2032 2039 2052

2065 2078 2085 2098

2111 2124 2131 2144

2157 2170 2177 2190

2203 2210 2223 2236

2249 2256 2269 2282

2295 2302 2315 2328

2341 2348 2361 2374

2387 2394 2407 2420 2427

2440 2453 2466 2473

2486 2499 2512 2519

2532 2545 2558 2565

2578 2591 2604 2611

2624 2637 2644 2657

2670 2683 2690 2703

2716 2729 2736 2749

2762 2775 2782 2795

2808 2815 2821 2828 2841

2854 2861 2874 2887

2900 2907 2920 2933

2946 2953 2966 2979

2992 2999

http://www.pathcom.com/~ericp/tala.html
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Exciting Images

W
hen people think of images of far-off galaxies and

all manner of other exciting objects, it is the Hubble

Space Telescope that most often springs to mind.

Yes, it has had a few problems but it has still managed to

gain us tremendous knowledge and capture the minds of

people in a way not seen since Apollo. This site not only has

a spiffy collection of Hubble’s high-quality images of galaxies,

stars, the Solar System, and nebulae, but the site’s authors

are eager to hand out photos for you to print out — providing

not only step-by-step instructions (geared to kids), but also

a variety of resolutions, all the way up to 16 × 20-inch wall

hangings, if you are lucky enough to own a printer that large

(and an ink factory). The other notable thing about this site

is that it gives an insight to the Hubble’s launch, repair, and

ongoing operations through its images. For readers who

prefer movies, it is a veritable video store, with intriguing

explorations of astronomical objects, and Hubble launch,

maintenance, and repair missions. Highly recommended is

a video of the Helix Nebula that will reveal its surprising 3-

dimensional shape. Movies are in QuickTime, but the photos

come in a variety of formats. Be prepared for a big download

and if the collection entrances you, there is a wallpaper

selection to keep on your desktop. This site is especially

easy to navigate, and kids and adults can while away the

afternoon in this electronic attic.
http://hubblesite.org/gallery

Origins

How did galaxies form? Are there life-sustaining planets

around other stars? Is somebody out there?

These questions and others form the basis of the Origins

site, though they may be a tad optimistic in promising that

“some of the answers are within our grasp.” The site is a

kind of omnibus gallery of NASA missions that are related

to the questions — missions with ominous names such as

WIRE, FUSE, SIM, and PI. It is not a stand-alone site in its

own right, but more a set of links to “origin”-related explorations,

some of them very advanced and loaded with resources and

educational materials. The site is designed well but a few

of the links to missions do not work (in particular, to Keck

and Palomar) and I have to put in a caveat that the site is a

little out of date — not old, but too new. Some of the deeper

part is still under construction. Still, the titles are intriguing,

and worth revisiting on occasion to see what’s happening

once some content is installed. As it is, the site is worth a

visit and the links will keep you busy for a considerable time.

In the not-too-distant future, the question of origins will

be uppermost on our astronomical minds and we will all

be looking here.

http://origins.stsci.edu/under/understanding.shtml

Paul Langan is President and CEO of a multinational company and

a Fellow of the Royal Commonwealth Society, but his heart is more

directed to the stars. If you have recommendations for future site

visits, please email him at the address above.

Net Astronomy

by Paul J. Langan (Paul@Langan.ca)

HST spacecraft.

mailto:Paul@Langan.ca
http://hubblesite.org/gallery
http://origins.stsci.edu/under/understanding.shtml
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A Concise History of Solar

and Stellar Physics, by Jean-

Louis Tassoul and Monique

Tassoul, pages 282 + xiii, 16 cm

× 24 cm, Princeton University

Press, 2004. Price $39.95 US

hardcover (ISBN 0-691-11711-

X).

You know you are getting old

when you encounter the names

of colleagues, friends, and co-

authors of your research papers

in a history book on your field

of study. That was my sobering

experience as I thumbed through Jean-Louis and Monique

Tassoul’s A Concise History of Solar and Stellar Physics.

Normally I do not get terribly excited at the prospect of

reading through a dry history of the early years of astronomy,

particularly when many of the more notable characters are

better known for rather absurd ideas and some of the more

colourful characters led lives far outside the standard fare

of the present era. But Concise History manages to present

a fresh outlook on the history of stellar astronomy, a field

of study that I sometimes worry may soon become extinct.

The outcome is a delightfully readable and comprehensive

study of the major developments in stellar astronomy over

the past few millennia.

Concise History is an extremely well-written book, and

I say that with great respect given that I daily put up with

the illiterate writing that is commonplace in recent journal

papers, not to mention in an upper-year course textbook

that has a dangling participle in every other sentence! By

comparison Concise History was a breath of fresh air for me,

and I eagerly lapped up each chapter. In the process I found

myself learning a lot about my field of which I was previously

unaware. An example is Kelvin-Helmholtz contraction, or

more properly Helmholtz-Kelvin contraction, which, as an

energy source for the Sun and stars, originated with the

Scottish physicist John James Waterston. Like many concepts

in astronomy, it is the popularizer, not the originator, who

is eventually associated with it.

The book also presents astrophysical concepts through

the development of equations, so in that respect it is also

very much like a course textbook. But one with a difference

— Concise History contains some very elegant developments

of fundamental equations that presents them in a fashion

that makes it far easier for students of the discipline to

grasp than is the case in every other textbook in my experience.

I found myself mentally placing tabs here and there throughout

the book to assist me later in preparing course notes for my

stellar-astronomy course. It is to the credit of the authors

that they have managed to transform the often dry plodding

of equation development into a revelation of how simple

concepts are used to develop more complex results. At times

the book is quite brilliant in how ideas are presented.

That having been said, I was a bit dismayed to find that

the writing style of the book tended to degenerate towards

the end, as the authors traced historical developments

contemporaneous with their own research careers. Here,

sadly, the writing style tends more towards the North

American jargonese that promulgates the current literature

in the field.

There are a number of recurring themes throughout

the book: the Sun, development of ideas in stellar evolution,

end stages of evolution, and pulsation theory of variable

stars, to name the most prominent. All are infinitely readable

and educational. It is instructive to follow how concepts

developed and changed with time, the early incorrect ideas

about stars evolving towards cooler surface temperatures

and lower luminosities being but one of them. It is also

interesting to see how the authors fit some of the lesser-

known ideas into the grand picture. Here, for example, I

mention the work of Olin Wilson in helping to develop the

study of ionized calcium flux variability in stars as analogous

to the solar sunspot cycle, that of Bill Herbst in studying

rotation in T Tauri stars through their periodic brightness

fluctuations, and the work by the authors themselves (not

to mention that by my Université de Montréal colleagues)

on white dwarf asteroseismology. Nothing seems to have

been omitted, and it is nice to see how current research

extends and clarifies the work of our earliest ancestors doing

stellar astronomy.

Overall Concise History is probably not a book for

everyone. Mathematical developments are introduced fairly

early in order to describe first-year concepts such as distance

from parallax and the Doppler effect in stellar spectral line

displacement, and reach a pinnacle with the Lane-Emden

equations describing polytropic models of stars. Instructors

will find the book to be a valuable resource in that regard,

particularly for developing the history of how important

ideas evolved. More casual readers could easily skip the

Reviews of Publications
Critiques d’ouvrages
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numbered equations and still find a lot to interest them. It

is, quite simply, an excellent summary of the important

developments in stellar astronomy over the ages. There are

still some of us out there who are interested in stars, right?

David Turner

David Turner is book review editor for the JRASC as well as a

professor in the Department of Astronomy and Physics at Saint

Mary’s University. His research is centred on stellar astronomy,

which he believes is still one of the most exciting fields in astronomy.

Mauna Kea: A Guide to Hawai’i’s Sacred Mountain, by

Leslie Lang and David A. Byrne, pages 146 + vi, 14 cm × 21.5

cm, Watermark Publishing, 2005. Price $17.95 US softcover

(ISBN 0-975-37405-2).

Mauna Kea is a special place — sacred to Hawaiians because

of its significance to their culture, and sacred to astronomers

because of the exceptional seeing conditions. A trip to the

Hawaiian Islands by anyone with an interest in astronomy

should include a visit to Hawaii (the Big Island) in order to see

the observatories and to experience the observing conditions

at the summit of Mauna Kea.

Such a visit is truly an adventure that must be planned

carefully. The summit is about two hours away from the two

most popular tourist destinations on the Big Island, Kona and

Hilo. The summit of Mauna Kea is at an altitude of 4 km, which

places it above almost half of the Earth’s atmosphere and thus

half of its oxygen. Typical daily temperatures range from -5 C

to +5 C. The access road is rough and, without due care, can be

treacherous. Such conditions make for a rigorous journey.

In spite of the challenges, the trip is well worth the effort.

The general observing conditions at the summit of Mauna Kea

are, arguably, the best in the world. The seeing at times rivals

that available to the Hubble Space Telescope. The view of both

land and sky is magnificent! Anyone with a strong interest in

astronomy, the requisite physical condition, and the resources

to get to the summit, should pay a visit. It is an unforgettable

experience.

Mauna Kea: A Guide to Hawai’i’s Sacred Mountain is an

excellent resource for planning such an adventure and for

understanding the mountain. The authors of the Guide are

locals to the Big Island. David A. Byrne is the manager of the

Mauna Kea Visitor Information Station that is located about

1.4 km below the summit at Hale Pohaku. Leslie Lang is a writer

who lives on a slope of Mauna Kea.

The Guide is divided into nine chapters: Visit Mauna Kea,

The Sacred Mountain, Natural History, Recreation, Visitor

Information Station, Astronomy on Mauna Kea, Maunakea

Discovery Center, The Future, and Resources.

The first chapter carefully outlines all that a traveller needs

to know about conditions at the summit and how to get there.

http://www.bookshawaii.net
http://www.imiloahawaii.org
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It lists and describes natural and historical sites that one can

see and/or explore along the road leading to the summit. The

importance of the mountain in Hawaiian culture is sensitively

treated in the second chapter. It is important to appreciate that

the Hawaiians are truly generous in permitting the astronomical

community to use the summit for research.

Of most interest to astronomers, chapter 6, “Astronomy

on Mauna Kea,” lists the properties of the mountain that make

it ideal for astronomy, and provides a detailed “Self-guided Drive

to the Summit,” which guarantees that you will see everything.

It is followed by a detailed description of each of the observatories

at the summit. The descriptions include a brief history, details

of the instrumentation, and research areas. The Guide also

provides Web site URLs for each of the observatories. Good

preparation for a trip to Mauna Kea would include viewing the

Web sites in order to become familiar with those observatories.

Since there is so much to see and do at the summit and the time

actually spent at the summit is inevitably brief, advance

familiarization by reading the Guide and viewing the Web sites

would greatly enhance the experience. Visitors from Canada

would be especially interested in visiting the observatories that

Canada supports: the Canada-France-Hawaii Telescope, the

James Clerk Maxwell Telescope, and the Gemini North Telescope.

The Guide is filled with many photographs, of which some

are magnificent examples of what awaits. There are four maps:

Island of Hawai’i, Summit Area, Cultural and Religious Sites,

and Observatories and Facilities. The maps are useful in finding

many of the locations mentioned in the text. Unfortunately, the

Cultural and Religious Sites map is very sketchy and extremely

difficult to relate to the other maps and to the text. Perhaps a

future edition of the Guide will improve the map since much

of the discussion in Chapter 2 relates to it.

Overall, the Guide will be very useful for visiting Mauna

Kea. I wish that it had been available during the year that I spent

living on the Big Island. It would have enriched my understanding

and appreciation of Mauna Kea. I plan to use it during my next

visit to locate the Adze Quarry near the summit that I did not

even know existed.

Richard Bochonko

Richard Bochonko, a Senior Scholar in the Department of Physics

and Astronomy at the University of Manitoba, is enjoying his

retirement in Victoria. He spent his sabbatical leave in 1983-4

working at CFHT on the Big Island.

Two lunar sketches
by Guy Mackie, Okanagan Centre. 

These lunar sketches by Guy Mackie of the Okanagan Centre show two of the thousands of attractions available to lunar observers. The left image, of Aristarchus,
Herodotus, and Schröter’s Valley, shows an area that has long fascinated amateur astronomers. The crater Aristarchus, toward the lower left, has a diameter of 46
km and is the brightest feature on the Moon. It has been reported as a source of Transient Lunar Phenomena (TLPs). According to the Lunar Section of the Association
of Lunar and Planetary Observers (ALPO), transient lunar phenomena can consist of red glows, flashes, obscuration, and abnormal albedo and shadow effects. Curving
around the centre of the drawing and ending just under the crater Herodotus is Schröter’s Valley. The terminus of the Valley, where it widens, is known as the Cobra’s
Head.

The right hand drawing shows the crater Arago and two volcanic domes, Arago Alpha and Arago Beta. The two domes are subtle features, 20-26 km in size, best seen
under oblique lighting conditions. Volcanic domes on the Moon are akin to shield volcanoes on the Earth and tend to be wide, rounded, circular features formed by
highly viscous lava erupting from vents. Arago Alpha and Beta are among the largest and most-distinct domes on the Moon. 
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Astrocryptic
by Curt Nason, Moncton Centre

ACROSS

1. A jumbo nuclear explosion from the old LMC (8,5)
8. Theoretical time standard from an average star (4,3)
9. Southern sky figure across or within dust lanes (5)

10. Southern star followers rearranged Greek character (5)
11. Electric motors around with no end to ocular wire (7)
12. Health club opens near the Church of England in the final

frontier (5)
14. Mislabel a catalogue of galaxy clusters (5)
16. Greek cross half rusted by a radio source in M1 (6,1)
18. Put us in gas chamber to measure magnetic field (5)
20. Rigel begins in clenched hand at this magnitude (5)
21. One on time will be sick antisunward of a comet (3,4)
22. Blue rain leaps out of old galaxies (6,7)

DOWN

1. Men turn to eastern sibling when faced with solar system
disruptor (7)

2. Boast about gravitational acceleration x-tal X-ray spectrometer
(5)

3. Professional astronomers from French line of Kembles (7)
4. Earth wobbles to turn a lunation around (5,8)
5. Wet one in our space telescope (5)
6. Past President Star Wars knight touches Dickens midsection

(7)
7. Earl tossed roses in the whirlpool (5)

13. Somehow Iraqi gold symbolically belongs to a bearer of water
(7)

14. Big lane swirling near Gamma Pegasi (7)
15. The room in Québec where Les Observateurs de la Magnitude

Absolue meet
16. Spats arising from image file formats (5)
17. Return in smart lunar probe to beyond beginning (5)
19. You soundly hula around a way to cart your big scope (1-4)
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The Beginner’s Observing Guide
Extensively revised and now in its fifth edition, The Beginner’s Observing Guide is for a variety of
observers, from the beginner with no experience to the intermediate who would appreciate the clear,
helpful guidance here available on an expanded variety of topics: constellations, bright stars, the
motions of the heavens, lunar features, the aurora, and the zodiacal light. New sections include: lunar
and planetary data through 2010, variable-star observing, telescope information, beginning
astrophotography, a non-technical glossary of astronomical terms, and directions for building a properly
scaled model of the solar system. 

Written by astronomy author and educator, Leo Enright; 200 pages, 6 colour star maps, 16 photographs,
otabinding. 

Price: $19.95  plus shipping & handling.
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Skyways: Astronomy Handbook for Teachers 
Teaching Astronomy? Skyways Makes it Easy! 

Written by a Canadian for Canadian teachers and astronomy educators, Skyways is Canadian
curriculum-specific; pre-tested by Canadian teachers; hands-on; interactive; geared for upper
elementary, middle school, and junior-high grades; fun and easy to use; cost-effective.

Skyways is complete with conceptual background; teacher information; student worksheets;
resource lists; Canadian contributions to astronomy section; FAQs; and more. Written by Canadian
author and RASC member, Mary Lou Whitehorne.

Price: $16.95 Cdn (members); $19.95 Cdn  (non-members)
(includes postage and handling; add GST for Canadian orders)

Observer’s Calendar — 2007
The award-winning RASC Observer's Calendar is your annual guide 

Created by the Royal Astronomical Society of Canada and richly illustrated by
photographs from leading amateur astronomers, the calendar pages are packed
with detailed information including major lunar and planetary conjunctions,
meteor showers, eclipses, lunar phases, and daily Moonrise and Moonset times.
Canadian and U.S. holidays are highlighted. Perfect for home, office, or
observatory.

Individual Order Prices:
$16.95 Cdn/ $13.95 US

RASC members receive a $3.00 discount
Shipping and handling not included.
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